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No. F  Composants I  Parti
1 Antenne GSM Antenna GSM
2 Base magnétique Base magnetica
3 Câble antenne Cavo antenna
4 Connecteur SMA pour antenne GSM Connettore SMA per antenna GSM
5 LED de contrôle LED di controllo
6 Port Carte SIM Porta SIM-CARD
7 Trous de fixation carte Fori di fissaggio scheda
8 Carte SIM SIM-CARD

9 Connecteur câble pour la
programmation via PC

Connettore cavo per la programmazione
da PC

10 Bornier pour les branchements Morsettiere per collegamenti
11 Ouverture pour passage câble antenne Apertura per passaggio cavo antenna
12 Trous de fixation étrier métallique Fori di fissaggio staffa metallica
13 Étrier métallique Staffa metallica
14 Support plastique adhésif Supporto plastico adesivo
15 Commutateur anti-sabotage (optionnel) Deviatore antisabotaggio (opzionale)
16 Support carte Supporto scheda
17 Fond métallique Fondo metallico
18 Couvercle Coperchio
19 Trous pour la fixation du fond Fori di fissaggio del fondo

20 Goujons d'assemblage du Commutateur
Anti-sabotage

Perni di fissaggio del Deviatore
Antisabotaggio

21 Écrous pour la fixation du Commutateur
Anti-sabotage

Dadi per il fissaggio del Deviatore
Antisabotaggio

22 Ouverture, sur le fond, pour le passage
des câbles

Apertura, sul fondo, per passaggio cavi

23 Ouverture, sur le fond, pour le passage
du câble d'antenne

Apertura, sul fondo, per passaggio
cavo antenna

24 Trous pour la fixation du couvercle Fori di fissaggio del coperchio
25 Vis pour la fixation du couvercle Viti di fissaggio del coperchio
26 Languette d'arrêt du câble Linguetta fermacavo

27 Trous pour l'insertion des supports de
carte

Fori per l'inserimento dei supporti
scheda
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Fig. 1 - Composants - Identificazione delle parti
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DSC (Digital Security Controls) déclare que la série
GS3105 et GS3125

est conforme aux conditions essentielles et aux autres dispositions établies par la Directive 1999/5/CE.
La Déclaration de Conformité complète peut être obtenue à l’adresse: www.dsc.com

Les modèles suivants ont été certifiés conformes par Telefication aux normes EN 50136-1-1 et EN 50136-2-1 avec des prestations du Système de
Transmission d'Alarme ATS 2 (D2, M2, T2, S0, I0): GS3105-K, GS3125-K, GS3105-BA et GS3125-BA.

L’installation des dispositifs doit être effectuée de façon adéquate, en accord avec les normes en vigueur. Ces appareillages ont été développés
selon les critères de qualité, fiabilité et de prestations adoptés par DSC. Il est recommandé de vérifier le bon fonctionnement du système au

moins une fois par mois. Les procédures pour la révision dépendent de la configuration du système. Demander à l’installateur du systèmes les
procédures à suivre. DSC décline toute responsabilité en cas de manipulation des appareils par des personnes non autorisées. Le contenu de ce

manuel peut être sujet à des modifications sans préavis et ne représente aucun engagement de la part de DSC.

Informations sur le recyclage
DSC recomande à ses clients de jeter le materiel appareils usagés (centrales, detecteurs, sirènes et autres dispositifs) de manière à protéger

l'environnement. Les methods possibles incluent la reutilisation de pieces ou de produits entiers et le recyclage de produits, composants, et/ou matériels.
Pour obtenir davantage d'informations, voir http://www.dsc.com

Directive sur la mise au rebut des appareils électriques et électroniques  (WEEE)
 En Union européenne, cette etiquette indique que ce produit ne doit pas être jeté avec les déchets ménagers. Il doit être

mis au rebut dans un centre de dépôt spécialisé pour un recyclage approprié.
Pour obtenir davantage d'informations, voir http://www.dsc.com
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INTRODUCTION
Les dispositifs de la série GS3105 et GS3125 sont des transmetteurs GSM qui, en l’absence de ligne PSTN, envoient des alarmes
vocales ou numériques, par le biais du GPRS, aux récepteurs System III ou System II. Sont disponibles pour chaque série:
— Kit GS3105-K et GS3125-K fourni avec carte transmetteur GSM/GPRS, antenne avec câble de 2 m, étrier métallique
et câble PCLINK-PCLINK;
— Kit GS3105-BA et GS3125-BA fourni avec carte transmetteur GSM/GPRS, antenne avec câble de 25 cm, boîtier et câble PCLINK-PCLINK;
— Kit GS3100-BX fourni avec une antenne avec câble de 25 cm et boîtier.
Les informations qui concernent une version spécifique seront mises en évidence par une référence au code correspondant. Le terme
“Transmetteur” sera utilisé pour décrire les fonctions communes aux différentes versions. Ce manuel fournit les instructions pour la
programmation et l’utilisation du Transmetteur. Pour les cas particuliers d’installation, l’antenne à distance extérieure ANT-EU est disponible.
 Ce Transmetteur doit être installé uniquement par des Personnes Qualifiées (une Personne Qualifiée a la

préparation technique appropriée et l’expérience nécessaire pour être consciente des dangers auxquels elle
pourrait être exposée durant le déroulement d’un travail, et des mesures pour minimiser les risques pour
elle-même et pour les autres personnes). Ce Transmetteur doit être installé et utilisé uniquement dans un
environnement subissant un degré 2 de pollution maximum, catégorie de surtension II, dans des lieux clos
et non dangereux. Ces instructions doivent être utilisées avec le manuel d’installation de la centrale. Toutes
les instructions présentes dans ce manuel doivent être observées.

Caractéristiques Générales

Caractéristiques Techniques
La tension d’alimentation pour ce Transmetteur est fournie par la Centrale ou bien par un alimentateur stabilisé (non fourni).

 Fournit une ligne PSTN simulée.
 Détection absence ligne PSTN et commutation

automatique sur Réseau GSM.
 Gestion et signalisation des appels entrants et sortants.
 Indicateur d'intensité du champ GSM.
 3 Bornes programmables comme Sorties Open-Collector

ou comme Lignes d'Entrée (seulement pour la série GS3125).
 Protection des surtensions sur la ligne téléphonique.
 GSM Quad-Band.
 Antenne avec base magnétique.
 Avertisseur SMS (seulement pour la série GS3125).
 Avertisseur Vocal (seulement pour la série GS3125).
 Décodification du Protocole Contact ID et envoi des

données via GPRS.
 Communication GPRS/Internet avec récepteurs Sur-

Gard System III / II.
 Options programmables depuis PC.

 Fonction Pass-through pour la liaison aux centrales
DSC Power PC1864 (seulement pour la série GS3125).

 11 Messages SMS, chacun d'une longueur maximum
de 100 caractères (2 pour chaque Ligne d'Entrée plus 4
pour les Signalisations d'État et 1 Périodique), seulement
pour la série GS3125.

 8 numéros de téléphone (max. 16 chiffres) programmables
pour l'Avertisseur SMS (seulement pour la série GS3125).

 4 numéros de téléphone programmables pour
l'Avertisseur Contact ID sur GPRS.

 Jusqu'à 100 numéros de téléphone (max.16 chiffres)
programmables pour l'activation à distance de la Sortie OC.

 Activation des sorties à distance par le biais de la
reconnaissance de l'appelant et/ou l'envoi de SMS (envoi
de SMS seulement pour la série GS3125).

 Contrôle du crédit restant des cartes SIM prépayées
(seulement pour la série GS3125).

 (PTM) monitorage des communications avec la centrale.

Versions GS3105-K, GS3125-K GS3105-BA, GS3125-BA

Tension d'Alimentation de 10 à 27,6 V_
Courant au repos 100 mA maximum (sans les sorties) à 13,8 Vcc
Courant  d'alarme maximal (transmission) 250 mA en moyenne (sans les sorties) à 13,8 Vcc
Sorties OC 3 open collector, de 100 mA
Fréquence de fonctionnement 900/1800 MHz ou bien 850/1900 MHz
Résistance maximum en série par ligne
des dispositifs reliés aux bornes LI

1 Kohm

Nombre maximum de dispositifs
branchables en parallèle aux bornes LI

1

Température de fonctionnement 5 ÷ 40 °C

Dimensions (HxLxE)
60,5x142x15,3 mm

(seulement pour la carte)
90x190x75 mm

(sans la antenne)
Poids 66 gr 348 gr
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Description Générale
Le Transmetteur peut communiquer avec les Centrales de Surveillance et, dans le cas de la série GS3125, envoyer des
messages à la fois SMS et vocaux; il peut simuler la ligne téléphonique PSTN en cas de panne (coupure de la ligne
téléphonique) ou remplacer complètement celle-ci dans les zones desservies par le service GSM et dans lesquelles la ligne
téléphonique PSTN n’est pas disponible. Il est capable de communiquer des évènements d’alarme à travers le réseau
GPRS, favorisant ainsi une communication fiable et rapide avec les centrales de vidéosurveillance dotées d’un récepteur
Sur-Gard System III ou System II. Les prestations de ce transmetteur dépendent fortement de la couverture du réseau GSM,
il ne devrait donc pas être installé avant d’avoir exécuté un essai de positionnement de l’antenne pour déterminer le meilleur
lieu de réception (au moins 1 LED verte doit être allumée).
Les Transmetteurs de la série GS3105 sont dotés de 3 sorties dont l’une peut être activée/désactivée à distance alors que les
2 autres sont utilisées pour les signalisations de: problèmes sur la ligne téléphonique PSTN; problèmes sur le réseau GSM.
Les Transmetteurs de la série GS3125 sont en revanche dotés de 3 bornes programmables comme:
— Sorties (réglage d’usine) qui peuvent être activées/désactivées à distance ou utilisées pour les signalisations d’état (problème
sur la ligne téléphonique PSTN, problème sur le réseau GSM, message de supervision manquant, échec de la communication).
— Lignes d’Entrée pour l’activation de l’Avertisseur Vocal et de l’Avertisseur SMS qui peuvent être utilisés également pour
envoyer des signalisations d’état.
En raison des caractéristiques du réseau GSM, ce Transmetteur doit être utilisé exclusivement dans ses buts prévus et ne
peut PAS être utilisé comme modem pour la transmission de fax et données ou pour des opérations de Téléassistance.

IDENTIFICATION DES COMPOSANTS
Les chiffres entre parenthèses carrées [ ] dans ce manuel, se réfèrent aux principaux composants de ce Transmetteur
illustrés sur la Figure 1.

INSTALLATION
  NE passer aucun fil au-dessus du circuit électronique.

 Ce Transmetteur doit être installé uniquement par des PERSONNES QUALIFIÉES, dans un lieu clos, sûr et
sec, loin des appareils radio-transmetteurs.

 Tester la réception du Réseau GSM avant d’installer ce Transmetteur à l’endroit choisi.

GS3105-K ou GS3125-K
 Ce Transmetteur se compose d’une carte destinée à être positionnée à l’intérieur d’une centrale antivol, de

préférence dans boîtier de métal, et d’une antenne qui est reliée à la carte via un câble coaxial. Pendant le
fonctionnement normal, ces éléments (carte, antenne et câble) peuvent constituer une source de champs
électromagnétiques rayonnés. Si des dispositifs électroniques se trouvent à proximité et dont l’immunité à de
tels champs est insuffisante, il est fort possible que se produisent des interactions non souhaitées. Pour cette
raison, nous conseillons de placer la carte le plus loin possible de ces dispositifs électroniques susceptibles
et l’antenne sur la surface extérieure du boîtier métallique, ou éloignée de celui-ci, à l’aide de l’étrier fourni. En
ce qui concerne le câble coaxial de liaison, nous conseillons de laisser à l’intérieur du boîtier métallique de
la centrale la longueur minimum nécessaire et de fixer l’excédent éventuel à l’extérieur du boîtier métallique.

1. Dévisser les vis et enlever le couvercle de la centrale.
2. À l’intérieur du boîtier métallique de la centrale, repérer une zone en mesure de recevoir le circuit, câblage compris.
3. Positionner les 4 supports plastiques adhésifs [14] sur le fond du boîtier métallique, puis insérer dans les trous [7]

présents sur le Circuit Électronique, les supports adhésifs, tel qu’illustré sur la Figure 2.
4. Monter l’antenne [1] à l’extérieur du boîtier.
4a. Positionner l’antenne [1] sur le boîtier métallique (Fig.2) de sorte que la base magnétique [2] adhère à la surface. Passer le

cordon de l’antenne dans une ouverture pour le passage des câbles.
Pour les cas particuliers d’installation vous pouvez utiliser l’étrier métallique [13], voir Fig.2a. Fixer l’étrier métallique [13] en
utilisant les trous [12] sur un support adéquat. Positionner l’antenne [1] sur l’étrier métallique [13] (Fig.2a), de sorte que
la base magnétique [2] adhère à la surface. Passer le cordon de l’antenne par le trou [11] de l’étrier métallique [13].

5.  Brancher le cordon [3] au connecteur pour antenne GSM [4].
6.  Effectuer les branchements sur les bornes [10].
7.  Insérer la carte SIM [8] dans le port SIM [6] tel que la flèche l’indique, avec les contacts vers le bas (voir Figure 1).
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!!!!! Le PIN de la carte SIM doit être désactivé avant qu’elle ne soit inséré dans le Transmetteur.
!!!!! Il est conseillé de désactiver le transfert d'appel sur votre CARTE SIM.

8. Contrôler lors de l’allumage que toutes les LED vertes clignotent; cet état signifie que le dispositif est en phase d’initialisation.
9. Contrôler l’intensité du signal:

– assurez-vous qu’au moins une LED verte soit allumée; toutes les LED vertes allumées indiquent une couverture parfaite.
– si les LED vertes sont éteintes, l’intensité du signal n’est PAS suffisant; changer la position de l’antenne jusqu’à
obtenir une intensité acceptable, au moins une LED verte allumée.

10.  Fermer le couvercle de la Centrale.
 Brancher l’alimentation et les circuits téléphoniques uniquement après que le Transmetteur ait été fixé et ait

été branché au circuit de terre de l’édifice.
!!!!! Avant d’insérer ou de retirer la carte SIM, assurez-vous que le Transmetteur  soit hors tension.

ANT-EU Antenne à distance
Pour le montage de l’antenne à distance extérieure ANT-EU, se référer aux instructions fournies avec ce produit. L’antenne
ANT-EU est utilisé pour fournir au Transmetteur un champ GSM d’une plus grande intensité.

GS3105-BA, GS3125-BA ou GS3100-BX
Voir figure 1.
1. Marquer la position des trous [19] pour fixer au mur le fond métallique [17].
2. Percer les trous dans le mur au niveau des points marqués précédemment.
3. Insérer les 4 supports de carte [16] dans les trous sur le fond métallique [27].
4. Passer les câbles pour les branchements à travers l’ouverture sur le fond [22].
5. Fixer le fond métallique sur le mur au moyen des chevilles (non fournies).
!!!!!  Attention à ne pas endommager les fils ou les gaines sous saignée.

6. Placer la Carte Électronique (non fourni avec le GS3100-BX) sur les supports [16] et la pousser vers le fond jusqu’à ce
qu’elle soit bloquée, tel qu’illustré sur la Figure 1.

7. Brancher le câble de l’antenne [3] au
connecteur sur la Carte Électronique [4].

8. Passer le câble de l’antenne [3] sous
la languette d’arrêt du câble [26], à
travers l’ouverture [23].

9. Placer l’antenne [1] sur le côté supérieur
du fond de sorte à ce que la base
magnétique [2] adhère à la surface.

 L’antenne peut être placée sur le côté
supérieur du fond, à l’endroit le plus
adapté pour recevoir le signal GSM.

10. Au besoin, monter le Commutateur Anti-
sabotage MAXIASNC [15] (optionnel) sur
les goujons tel qu’illustré sur la Figure 1.

 Le levier du Commutateur doit être
orienté comme sur la Figure 1,
sinon le dispositif ne fonctionnera
pas correctement.

11. Réaliser les branchements sur le bornier
[10] tel que décrit au par. “Branchements”
et, au besoin, le branchement du
Commutateur Anti-sabotage (pour le
branchement du Commutateur Anti-
sabotage voir le par. Branchements-
>Branchements auxiliaires).

51

96

a)

Fig. 2 - Montage carte à l'intérieur
de la centrale.
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12. Insérer la carte SIM [8] dans le port SIM [6] tel que la flèche l’indique, avec les contacts vers le bas (voir Figure 1).
!!!!! Le PIN de la carte SIM doit être désactivé avant qu’elle ne soit inséré dans le Transmetteur.
!!!!! Il est conseillé de désactiver le transfert d'appel sur votre CARTE SIM.

13. Contrôler lors du démarrage que toutes les LED vertes clignotent; cet état signifie que le Transmetteur est en phase d’initialisation.
14. Contrôler l’intensité du signal:

– assurez-vous qu’au moins une LED verte soit allumée; toutes les LED vertes allumées indiquent une couverture parfaite.
– si les LED vertes sont éteintes, l’intensité du signal n’est PAS suffisant; pour une intensité acceptable, au moins une
LED verte doit être allumée.

15. Fermer le Transmetteur: accrocher le côté inférieur du Couvercle [18] au Fond [17] puis appuyer sur le côté supérieur
du Fond pour fermer le Couvercle; bloquer le Couvercle avec les vis [25].

 Brancher l’alimentation et les circuits téléphoniques uniquement après que le Transmetteur ait été fixé et ait
été branché au circuit de terre de l’édifice.

!!!!! Avant d’insérer ou de retirer la carte SIM, assurez-vous que le Transmetteur soit hors tension.

BRANCHEMENTS
Ce chapitre décrit les bornes du Transmetteur et les branchements auxiliaires. Un exemple de branchement est illustré sur la Figure 3.

!!!!! Le courant des Open Collector ne peut dépasser 100 mA. Au cas où il serait nécessaire de commuter des
charges plus importantes, utiliser des relais.

Branchements auxiliaires
Les branchements auxiliaires ne sont pas indispensables pour que le Transmetteur fonctionne, mais ils permettent d'exploiter
au mieux la souplesse de ce dispositif. Ces branchements sont décrits dans le paragraphe suivant:

Antisabotage - Le branchement du Déviateur Antisabotage MAXIASNC (en option) permet de détecter d'éventuelles tentatives de
violation du couvercle du Transmetteur. Le Transmetteur Antisabotage est doté d'un câble pré-soudé et peut être branché ainsi:
—  À la ligne antisabotage ou à une zone appropriée de la centrale. Pour de plus amples informations, lire les instructions de la centrale.
— Entre la borne [ T3 ] et [ M ] du GS3125, de sorte que lors du retrait du couvercle du Transmetteur, un message SMS et/ou vocal
soit envoyé à un ou plusieurs numéros de téléphone. Dans ce cas, vous devez programmer le Transmetteur par le biais du logiciel
GS3100 Series Console (voir le paragraphe Programmation via PC->Programmation optionnelle Antisabotage).
Une fois les branchements et la programmation effectués, refermer le couvercle et alimenter le Transmetteur. À la fin de la phase d'initialisation
du Transmetteur GSM, ouvrir le couvercle et vérifier que le message SMS et/ou vocal est bien envoyé aux numéros programmés.

N. Bornes
Versions

GS3105-K, GS3105-BA GS3125-K, GS3125-BA

1 +V

Alimentation fournie par la centrale ou par l'alimentateur externe (optionnel), de 10 à 27,6 Vcc, assurez-vous qu'elle soit
protégée et limitée en courant: source d'alimentation limitée (LPS) en accord avec la réglementation EN 60950-1:2006.

!  Pour brancher l'alimentation, utiliser des câbles d'une longueur maximum de 2 mètres et 0,75 mm² de section.
Pour des câbles d'une longueur inférieure, utiliser des sections adéquates.

2 M Masse: moins de l'alimentation et borne commune pour les Sorties Open Collector.

3 T1
Sorties Open-Collector: ces sorties sont activées par les
évènements de pannes sur la ligne PSTN (T1) ou sur le
réseau GSM (T2).

Bornes Programmables, c e s b o rne s p e uve nt ê tre
programmées comme:
– Sorties Open-Collector (réglage d'usine): ces sorties
peuvent être activées par les éléments programmés
(Activation Automatique), ou bien soit par le biais d'une
commande sur message SMS soit au moyen de la
reconnaissance de l'appelant (Activation à Distance); lire
le paragraphe “Activation des Sorties” pour de plus
amples informations. Le courant maximum pouvant être
prélevé par chaque Sortie OC est de 100mA.
– Lignes d'Entrée: lorsque ces entrées reçoivent des
Signaux d'Alarme, elles peuvent activer les fonctions
d'Avertisseur SMS et d'Avertisseur Téléphonique (lire les
paragraphes “Avertisseur SMS” et “Avertisseur Vocal”).

4 T2

5 T3

Sortie Open-Collector Programmable: cette sortie peut être
activée par l'évènement reconnaissance de l'appelant. Le
courant maximum qui peut être prélevé par chaque Sortie
OC est de 100mA.

6 -
Terre: cette borne doit être branchée à la Terre de l'installation électrique pour protéger le dispositif des surtensions sur
la ligne téléphonique et pour satisfaire les conditions de sécurité.

7
LE Ligne Téléphonique Externe: ces bornes peuvent être branchées à la ligne téléphonique PSTN.

8
9

LI Ligne Téléphonique Interne: ces bornes doivent être branchées à la centrale ou à un autre terminal de communication.
10
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Fig. 3 - Exemple de branchement pour la série GS3105 et GS3125.

Alimentation
de 10 à 27,6 Vcc

Alimentation
de 10 à 27,6 Vcc

Sorties Open Collector
 DEBRANCHER LES LIGNES 
TELEPHONIQUES AVANT LA 

MANUTENTION

Ce branchement
est indispensable

ATTENTION:
Des branchements erronés peuvent provoquer le défaillance des appels et un mauvais fonctionnement. Inspecter le câblage et
assurez-vous que les branchements soient corrects avant d’appliquer l’alimentation. NE passer ACUN fil au-dessus des circuits
électroniques; maintenir une distance d’au moins 25 mm.  Une distance d’au moins 6 mm doit être maintenue sur tous les 
points entre le câblage à Basse Tension et tous les autres types de câblage PSTN.

BRANCHEMENT A TERRE

Branchement à la
Ligne Téléphonique

(PSTN)

Central Antivol

BRANCHEMENT A TERRE

Branchement à la
Ligne Téléphonique

(PSTN)

 DEBRANCHER LES LIGNES 
TELEPHONIQUES AVANT LA 
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Ce branchement
est indispensable

Central Antivol

Exemple de branchement de les 
bornes T1 et T2 programmées 
comme Sortie Open Collector

RJ-11

RJ-11
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P
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G
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Exemple de branchement
 de la borne T3 

programmée comme 
Lignes d'entrée

Relè
RM-1



10 Transmetteur d'alarme GSM/GPRS

LED DE CONTRÔLE
Il y a 5 LED sur la fiche (voir Figure 4); trois vertes (L1, L2 et L3), une LED jaune (L4), une LED rouge (L5), qui signalent la connexion,
la transmission, les conditions de disfonctionnement et, uniquement pour la série GS3125 (voir tableau 2), l’état du Transmetteur.
 Durant le démarrage et durant la phase de programmation, les LED clignotent.
ROUGE — LED normalement éteinte. Signale une condition de disfonctionnement, clignotante en cas de panne.

Ce Transmetteur contrôle la présence de certaines pannes dans l’ordre indiqué ci-dessous. L’état de disfonctionnement
le plus important sera indiqué par le nombre de clignotements de la LED ROUGE (L5) (voir ci-dessous pour le nombre
de clignotements et la priorité des signaux de disfonctionnement).

JAUNE — Allumée, elle indique que l’interface a commuté sur le réseau GSM à cause d’anomalies sur la Ligne
Téléphonique PSTN ou absence de celle-ci. Un clignotement lent, indique qu’un appel est en cours sur le réseau GSM
(tant en entrée qu’en sortie). Si elle est allumée fixe en même temps que la LED rouge, cela indique le chargement des
données d’usine en cours.

VERTE — Les trois LED vertes (L1, L2 et L3), signalent l’intensité du champ GSM et l’état (tableau 2), tel qu’illustré sur la Figure 4:
La première LED (L1, à coté du trou de fixation) indique lorsqu’elle est éteinte que le Réseau GSM n’est PAS disponible.
Si cette LED est le seul allumée, le niveau du signal GSM est bas mais suffisant pour effectuer les appels vocaux;
La seconde LED (L2), indique lorsqu’elle est allumée, une bonne intensité de champ GSM: cette LED s’allume
uniquement lorsque la première LED verte est allumée;
La troisième LED (L3), indique lorsqu’elle est allumée, une excellente intensité de champ GSM: elle s’allume
uniquement lorsque la première et la seconde LED sont allumées.

1 2 3 4 5Numération LED 
(références non présentes sur le 

Circuit Electronique).
 Cette numération a été 

insérée uniquement pour une
meilleure identification des
LED au sein du document.

 
 

LED indicateurs de champ GSM Symbole niveau signal GSM
LED de contrôle

Fig. 4 - LED de contrôle.

Priorité Signalisation Type Disfonctionnement
Clignotements LED

Rouge
1 (HAUTE) Problème Firmware (firmware incorrect) 1

2 Problème alimentation 2

3 Problème module GSM 3

4 Problème SIM 4
5 Problème de champ GSM 5

6 Problème GPRS 6

7 Récepteur indisponible 7
8 (BASSE) Récepteur de supervision absent (récepteur 1) 8

Aucune panne Éteint
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PRINCIPES DE FONCTIONNEMENT
Ce transmetteur offre la possibilité de choisir un “Canal Prédéfini ” de communication. Il fournit la tension de ligne et de sonnerie
pour les appels entrants et décode la Sélection Multifréquence (DTMF). La Simulation de la Ligne téléphonique PSTN fournit à
la centrale antivol ou à un autre terminal de communication, une ligne de réserve en cas de panne sur la PSTN. La commutation
entre PSTN et GSM, et vice et versa, n’a PAS lieu durant les appels en sortie. La Priorité de Fonctionnement (à sélectionner
durant la phase de programmation) détermine comment ce Transmetteur gère les communications (SMS et vocales) et les
appels des dispositifs téléphoniques branchés aux bornes LI (par exemple une centrale antivol).
 Il n’est PAS en mesure de décoder la Sélection à Impulsions (Décadique).
 Pour prévenir une utilisation indésirable de la ligne simulée via GSM, durant les appels vocaux le dispositif génère un

double bip de signal. Le premier double bip est généré après 5 minutes et les bips suivant à un intervalle de 30 secondes.

Rétablissement de la Programmation par défaut
Pour rétablir la programmation d’usine du Transmetteur, suivre les étapes suivantes:
1. Débrancher l’alimentation du Transmetteur.
2. Tout en maintenant les broches de contact 1 et 4  du connecteur court-circuitées [9] (fig.5 page 17), rétablir l’alimentation.
3. Les 5 LED (L1, L2, L3, L4 et L5) s’allument durant quelques instants (moins d’une seconde).
4. Dès que le court-circuit est détecté par les 3 LED vertes (L1, L2, L3), celles-ci s’éteignent alors que les LED jaune et rouge (L4,

L5) restent allumées (quelques secondes) afin d’indiquer que le rétablissement des programmations par défaut est en cours.
5. Lorsque les LED jaune et rouge s’allument (L4, L5), éliminer le court-circuit des broches de contact 1 et 4 du connecteur [9] (fig.5 page 17).
6. Une fois la procédure terminée, les 3 LED vertes clignotent pour signaler que le Transmetteur est en phase d’initialisation.
 Les messages vocaux enregistrés ne sont pas supprimés en cas de rétablissement des paramètres d’usine.

Canal Prédéfini PSTN
Si la tension sur les bornes de la Ligne Téléphonique PSTN (LE) diminue à moins de 3 Vcc durant un temps compris entre 10 et 3600
secondes (valeur programmable), les dispositifs téléphoniques reliés aux bornes LI sont commutés sur le Réseau GSM. Au rétablissement
de la Ligne Téléphonique PSTN, celle-ci commute à nouveau après un temps programmable sur la Ligne Téléphonique PSTN.

Canal Prédéfini GSM
Il fournit aux dispositifs branchés aux bornes LI la ligne simulée si la couverture GSM est présente. En cas d’absence de
champ GSM, il commute sur la Ligne Téléphonique PSTN.

Séquence Transmission Contact ID sur GPRS
Le Transmetteur, au cas où des numéros de téléphone auraient été insérés sur la page Gprs->Telephone numbers to
decode via le software GS3100 Series Console, adresse les appels à ces numérations sur la ligne GPRS.
  Lorsqu’un évènement se produit, la centrale antivol prend la ligne téléphonique.
 Ce Transmetteur simule la tonalité.
 La centrale antivol compose le numéro de la Centrale de Télésurveillance. Assurez-vous que la centrale antivol insère

une pause d’au moins 1 seconde ou bien qu’elle vérifie la présence de la Tonalité avant de composer le numéro.
 Ce Dispositif envoie l’invitation à transmettre au format Contact ID.
 Après avoir reçu l’invitation, la centrale antivol transmet les évènements d’alarme au format DTMF.
 Le Transmetteur décode et transforme les chiffres DTMF en paquets et les envoie au récepteur de la Centrale

deTélésurveillance par le biais du réseau GPRS.
 Le récepteur reconnaît l’événement et envoie la commande au transmetteur qui génère le signal de kiss-off (la fréquence

de ce signal est de 1400 Hz) à la centrale.
 Après que le Transmetteur ait émis l’acquittement, la centrale raccroche si aucune autre alarme n’a besoin d’être envoyée.

Signalisations sur l'état du Transmetteur
Clignotements LED

Vertes
Signification de la signalisation

L1 Transmission message vocal en cours

L3 Session distante; clignote jusqu'à la fin de la session GPRS distante

L1+L2 Modalité de service; elles clignotent jusqu'à la sortie de la modalité

L2+L3 Message SMS entrant; clignotent pendant 5 secondes

L1+L2+L3
Le Transmetteur est en phase d'initialisation; elles clignotent

jusqu'à réception d'un signal GSM

Tableau 2 - Signalisations sur
l'état du Transmetteur pour la
série GS3125 au moyen du
clignotement des LED Vertes
(L1,L2,L3).
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Avertisseur SMS (seulement pour la série GS3125)
En mode de fonctionnement Avertisseur SMS, un ou plusieurs numéros de téléphone sont appelés (les 8 premiers numéros
de téléphone du répertoire) afin de leur envoyer les Messages SMS programmés précédemment associés aux évènements
suivants (voir le tableau suivant):

 Signaux d’Alarme qui pourraient se présenter sur une ou plusieurs des 3 Lignes d’Entrée Programmables.Souvenez-vous que pour
chacune des 3 Lignes d’Entrée du dispositif il est possible de programmer 2 Messages SMS:celui d’Activation et celui de Rétablissement.

 Test Ligne PSTN. Il est possible de programmer 2 SMS: celui d’absence de Ligne PSTN et celui de Rétablissement.
 Test tension d’Alimentation. Il est possible de programmer 2 SMS: un qui signale des problèmes de tension d’Alimentation

et un de Rétablissement.
 Envoi SMS Périodique avec une période programmable d’1 heure à 1 an.
 L’envoi d’un Message SMS a lieu lorsque l’un des évènements décrits ci-dessus se vérifie, pour lequel un

message SMS a été programmé ainsi qu’au moins un numéro de téléphone.

Avertisseur Vocal (seulement pour la série GS3125)
En mode de fonctionnement Avertisseur vocal, un ou plusieurs numéros de téléphone sont appelés (les 8 premiers numéros du
répertoire) afin de leur envoyer un message vocal préenregistré. Il est possible d’enregistrer jusqu’à 8 messages de la durée
maximum de 16 secondes chacun. Chaque message est enregistré sur des mémoires solides, éliminant ainsi tous les problèmes
liés à l’utilisation de bande magnétique, tels que: la détérioration de la qualité du message au fil du temps; le blocage de la mécanique
après de longues périodes d’inactivité, etc. Les messages sont associés aux évènements suivants (voir le tableau suivant):

N Description Évènement
Numéros de téléphone programmés
(8 premiers numéros du répertoire) Message SMS

1 2 3 4 5 6 7 8
1  Activation Entrée 1 *Chaîne SMS
2 Rétablissement Entrée 1 *Chaîne SMS
3 Activation Entrée  2 *Chaîne SMS
4 Rétablissement Entrée  2 *Chaîne SMS
5 Activation Entrée  3 *Chaîne SMS

6 Rétablissement Entrée  3 *Chaîne SMS
7 Problème Ligne PSTN
8 Rétablissement Ligne PSTN *Chaîne SMS

9 Problème tension d’alimentation
10 *Chaîne SMS
11 SMS Périodique *Chaîne SMS
  Évènement désactivé sur le numéro de téléphone
  Évènement activé sur le numéro de téléphone

  *   La chaîne du SMS peut avoir une longueur maximum de 100 caractères

Rétablissement tension d’alimentation

N Description Évènement
Numéros de téléphone programmés
(8 premiers numéros du répertoire) Mess. #1 Mess. #2 Mess. #3
1 2 3 4 5 6 7 8

1 Activation Entrée 1

2 Rétablissement Entrée 1
Message
Vocal 1

Message
Vocal 2

3 Activation Entrée 2

4 Rétablissement Entrée 2
Message
Vocal 2

5 Activation Entrée 3
6 Rétablissement Entrée 3
7 Problème Ligne PSTN
8 Rétablissement Ligne PSTN
9 Problème tension d'alimentation

10
11 Appel Périodique

  Évènement désactivé sur le numéro de téléphone
  Évènement activé sur le numéro de téléphone

Rétablissement tension d’alimentation
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 Signaux d’Alarme qui pourraient se présenter sur une ou plusieurs des 3 Lignes d’Entrée Programmables. Souvenez-
vous que pour chacune des 3 Lignes d’Entrée du dispositif il est possible de programmer 2 Messages vocaux: celui
d’Activation et celui de Rétablissement.

 Test Ligne PSTN. Il est possible de programmer 2 Messages Vocaux: celui d’absence de Ligne PSTN et celui de Rétablissement.
 Test tension d’Alimentation. Il est possible de programmer 2 Messages Vocaux: un qui signale des problèmes de tension

d’Alimentation et un de Rétablissement.
 Envoi Message vocal Périodique avec une période programmable d’1 heure à 1 an.
L’appel vocal est effectué lorsqu’un évènement a lieu sur un canal pour lequel un message vocal et au moins un numéro de
téléphone ont été programmés.
Dans ce cas le Transmetteur exécute les phases décrites ci-dessous:
1. Le Transmetteur sélectionne le numéro de téléphone et transfère l’appel sur la ligne téléphonique GSM.
2. Le Transmetteur vérifie que le numéro ne soit pas occupé ou qu’il n’y ait pas de problèmes sur le réseau GSM afin de

passer à la phase suivante, sinon l’appel prend fin et l’essai est reproduit depuis la Phase 1 jusqu’à un maximum de 8 fois
(selon la valeur programmée) après quoi le cycle d’appels est considéré terminé. Si le Canal d’Alarme a été programmé
pour appeler plusieurs numéros téléphoniques, ceux-ci seront appelés en séquence. En faisant ainsi, par exemple, il est
impossible de rappeler plusieurs fois dans un laps de temps de peu de secondes, un numéro occupé.

3. Le Transmetteur attend jusqu’à 60 secondes la réponse du numéro appelé. En cas d’issue positive, la Phase 4 démarre,
sinon l’appel prend fin et l’essai est reproduit depuis la Phase 1 jusqu’à un maximum de 8 fois (selon la valeur
programmée) après quoi le cycle d’appels est considéré terminé.

4. Le Transmetteur reproduit le message relatif au canal en alerte, l'appel est considéré terminé uniquement après la réception du message ou
bien lorsque la touche  est appuyée (si elle a été programmée, la "Call Confirmation", voir le paragraphe "Voice Dialer->Call
Confirmation") sur le téléphone qui a reçu le message. Dans tous les cas, l’appel est considéré réussi après que le message ait été répété
jusqu’à un maximum de 8 fois (selon la valeur programmée). Si, au moment de la sélection plusieurs évènements qui déterminent l’envoi
de différents messages au même numéro de téléphone se sont vérifiés, ces messages sont reproduits (chacun jusqu’à un maximum de
8 fois, selon la valeur programmée) en séquence durant le même appel en évitant d’appeler plusieurs fois le même numéro.
Si, à la fin du cycle d’appels, la Ligne qui a provoqué l’activation du Transmetteur est encore en alarme, la procédure
décrite ci-dessus ne sera plus exécutée. Il est nécessaire, en effet, que la ligne qui a provoqué un cycle d’appels se
remette en veille avant d’en activer un nouveau.

Gestion des Priorités (seulement pour la série GS3125)
Le Transmetteur est capable de transmettre les évènements d’alarme et les messages (SMS ou vocaux), certaines priorités
sont programmables par le biais du logiciel GS3100 Series Console (voir la partie relative à la programmation par le biais du
logiciel GS3100 Series Console); le tableau de gestion des priorités avec les réglages d’usine est représenté ci-dessous.

Priorité à la Ligne Téléphonique Simulée
Lorsque le dispositif branché sur les bornes LI demande la ligne, tout éventuel appel effectué à ce moment en modalité
Avertisseur Vocal prendra fin. Les appels requis par le dispositif branché sur les bornes LI (par exemple, une centrale
antivol), sont effectués ainsi. Lorsque le dispositif branché sur les bornes LI libère la ligne, l’Avertisseur Vocal effectue de
nouveau les appels laissés en suspens et envoie les messages vocaux.

Priorité Avertisseur SMS
Dans le cas où un appareil branché sur les bornes LI effectuerait un appel sur GSM à travers ce Transmetteur et qu’il serait nécessaire
d’effectuer une action de l’Avertisseur SMS, l’appel depuis l’interface ne se terminera pas et le message SMS sera de toute façon envoyé.

Priorité des Évènements de l’Avertisseur
Les messages SMS présentent une priorité inférieure à celles des messages vocaux, mais ils ne peuvent pas être interrompus
pendant l'envoi. Le cas échéant, le message vocal dans la file d'attente sera envoyé à la fin de l'envoi du message SMS.

Tableau de gestion des priorités

Priorité
Évènement

Description Évènement
Réglages
d'usine

Programmable
depuis logiciel

1 (HAUTE) Requête Ligne LI (déclenchement)  Oui
2 Avertisseur Vocal (messages vocaux)  Oui

*3 (BASSE) Supervision GPRS  Non

* L'évènement de Supervision GPRS est le plus bas et n'est pas programmable par logiciel
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Contrôle du crédit restant (pour la série GS3125)
En cas de programmation par le biais du logiciel GS3100 Series Console (voir la page Options->Pay As You Go), il est
possible de contrôler le crédit restant sur la carte SIM prépayée. En activant le contrôle du crédit restant, un SMS comprenant
les informations fournies par l’opérateur sur le crédit restant est envoyé périodiquement au premier numéro du répertoire. Pour
tous les opérateurs qui supportent la requête du crédit restant par le biais d’une commande de réseau, il est possible de saisir
la chaîne de caractères d’interrogation par le biais du logiciel GS3100 Series Console.
 NOTE - Le service de gestion du crédit des cartes SIM prépayées peut être suspendu selon la volonté de

l’opérateur du réseau GSM concerné.

(PTM) contrôle des communications avec la centrale
Le contrôle constant des communications avec la Centrale (fonction PTM) permet au Transmetteur d’envoyer les appels au moyen
du réseau GSM dans le cas où la communication entre la centrale d’alarme et la centrale de surveillance ne serait pas établie avec
succès sur la ligne téléphonique PSTN. Si elle est programmée (par le biais du logiciel GS3100 Series Console, page PTM), cette
caractéristique est opérationnelle uniquement lorsque la ligne PSTN est connectée aux bornes LE présentes.
La fonction PTM est liée aux modalités suivantes de transmission de l’alarme au Transmetteur:
1. Alarme sur GPRS (communications IP récepteur).
2. Alarme sur GSM (modalité voix).
 L'erreur PSTN apparaît lorsque la fonction PTM l'active.

ACTIVATION DES SORTIES
La série GS3105 possède 3 Sorties de type Open Collector (les bornes T1, T2 et T3). La série GS3125 possède 3 bornes
(T1, T2 et T3) qui peuvent être programmées comme Entrées et/ou Sorties: ces bornes sont programmées par défaut
comme Sorties. Les Sorties Open Collector peuvent être activées de façon automatique (lorsque certains évènements pré-
programmés se vérifient) ou bien à distance, par le biais de l’envoi d’un SMS (envoi d’SMS uniquement pour la série
GS3125) ou la reconnaissance de l’appelant d’un numéro programmé précédemment.

Activation et désactivation des Sorties “Automatique”
Les Sorties Open Collector T1, T2 et T3 de ce Dispositif peuvent activées de façon automatique par les évènements suivants:
 Absence de Ligne Téléphonique PSTN (T1, pour la série GS3105).
 Absence de Réseau GSM (T2, pour la série GS3105).
 Pas de message de supervision (pour la série GS3125).
 Échec de communication d'un évènement interne (FTC), (pour la série GS3125).
 Une Sortie OC activée automatiquement repasse à l'état de repos lorsque toutes les causes qui en ont

provoqué l'activation sont éliminées; sauf en cas d'échec de la communication d'un évènement interne
(FTC), dans ce cas elle repasse à l'état de repos après un temps programmé (Temps de ON).

Activation et désactivation des Sorties “Distant”
 ATTENTION - La connexion GSM doit être établie pour que les sorties puissent être activées/désactivées à distance.

Il est conseillé de programmer le dispositif avec la Black List (Options->Dial Options) et White List
(Phonebook->White List) pour les numéros à utiliser avec cette fonction.
Le numéro utilisé pour l’activation des sorties à l’aide de la Reconnaissance de l’appelant doit être visible.

GS3105
Les Sorties Open Collector T1 et T2 sont Bistables alors que la Sortie T3 est Monostable (la Sortie se désactive à
l’expiration du temps ON).

GS3125
Les Sorties Open Collector peuvent être réglées comme Bistables (l’activation et la désactivation ont lieu par l’intermédiaire
de 2 commandes différentes) ou bien comme Monostables (la Sortie reste active durant le Temps de ON après quoi elle
se remet en veille). En outre, chaque sortie peut être programmée pour fournir un signal de confirmation (un SMS programmé
précédemment si l’activation/désactivation de la sortie est faite au moyen d’un SMS, ou bien un coup de sonnerie de
confirmation si l’activation/désactivation a lieu à travers la reconnaissance de l’appelant.
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 Pour de plus amples informations sur les termes “Chaîne de Contrôle” et “Code Utilisateur” utilisés dans ce
paragraphes, consultez les paragraphes “I/O” et “Options->Codes” du chapitre “PROGRAMMATION VIA PC”.

Sorties Bistables (seulement pour la série GS3125)
Les Sorties Open Collector réglées comme Bistables peuvent être activées de 2 façons:
1. En envoyant un SMS formé du Code Utilisateur compris entre les caractères #, par la Chaîne de Contrôle (au début de

la Chaîne de Contrôle, il ne doit pas y avoir d’espaces vides) et par les caractères “=ON#” selon la syntaxe suivante:

#Code Utilisateur#Chaîne=ON#   (exemple: #9876#LUMIEREMAISON=ON#)

2. A travers la reconnaissance de l’appelant: dans ce cas la Sortie est activée “gratuitement” car le dispositif, après avoir
reconnu l’appelant, refuse l’appel et active la sortie.

  La désactivation d’une Sortie OC de type Bistable peut être faite UNIQUEMENT au moyen de l’envoi d’un
message SMS formé du Code Utilisateur compris entre les caractères #, par la Chaîne de Contrôle et par les
caractères “=OFF#” selon la syntaxe suivante:

#Code Utilisateur#Chaîne=OFF#   (exemple: #9876#LUMIEREMAISON=OFF#)

 Le Code Utilisateur réglé par défaut est ‘0001’, pour le remplacer, voir le paragraphe “Programmation à
distance par SMS->Modification du Code Utilisateur”.

Sorties Monostables
Les sorties OC définies comme Monostables peuvent être activées de deux façons à l’aide de la Reconnaissance de
l’appelant et par SMS (uniquement GS3125).

SMS (uniquement GS3125)
Envoyez un SMS avec le Code Utilisateur entre #, par la Chaîne de Contrôle (au début de la Chaîne de Contrôle, il ne
doit pas y avoir d’espaces vides) et par les caractères “=ON#”, “=ON#TonU#” ou bien “=OFF#”, selon la syntaxe suivante:

#Code Utilisateur#Chaîne=ON#
#Code Utilisateur#Chaîne=ON#TonU#

#Code Utilisateur#Chaîne=OFF#

Le paramètre “=ON#TonU#” permet de configurer le Temps de ON d’1 seconde à 86400 secondes, avec des écarts d’1
seconde.  Le Temps de ON peut être configuré également au moyen du logiciel de programmation du Transmetteur. La syntaxe
“Ton” représente la valeur et “U” l’unité exprimée en H (heures) M (minutes) et S (secondes), voir les exemple suivants:

 Pour activer la sortie par le biais d’un SMS en respectant la programmation, éliminer le paramètre “TonU”
en laissant les caractères “##”.

 (exemple: #9876#LUMIEREMAISON=ON##)

Reconnaissance de l’appelant
La Sortie est activée “gratuitement” car le dispositif, après avoir reconnu l’appelant, refuse l’appel et active la sortie.
 Une sortie OC Monostable sera désactivée (switcher à OFF) automatiquement lorsque le temps ON sera expiré.

 Seule la Sortie T3 du GS3105 peut être activée à l’aide de la Reconnaissance de l’appelant.
Le Temps On peut être réglé  d’1 seconde à 86400 secondes, avec des écarts d’une seconde.

 Le Code Utilisateur réglé par défaut est ‘0001’, pour le remplacer, voir le paragraphe “Programmation à
distance par SMS->Modification du Code Utilisateur”.

SMS Mode de fonctionnement des sorties

#9876#LUMIEREMAISON=ON# Activation Bistable

#9876#LUMIEREMAISON=ON#3600S# Active durant 3600 secondes

#9876#LUMIEREMAISON=ON#50M# Active durant 50 minutes

#9876#LUMIEREMAISON=ON#3600#
Active comme selon programmation
logiciel, le Temps de ON réglé n'est

pas valide
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PROGRAMMATION À DISTANCE PAR SMS
(pour la série GS3125)

En plus de celles décrites dans le paragraphe Activation et Désactivation des Sorties à distance, il est possible
d’effectuer d’autres opérations à distance en envoyant les messages SMS appropriés.

Modification du Code Utilisateur
Le Code Utilisateur réglé par défaut est ‘0001’, pour le remplacer, envoyer un message SMS composé des caractères “#CUC” suivis
de l’ancien Code Utilisateur et du nouveau Code Utilisateur compris entre les caractères * tel que selon la syntaxe suivante:

#CUC*Code Utilisateur*Nouveau Code Utilisateur*

Vous recevrez une confirmation par SMS si le Code Utilisateur a été modifié.
 Pour la composition du Code Utilisateur, seuls les chiffres de 0 à 9 peuvent être utilisés (maximum 4 chiffres).

Activer ou désactiver la programmation à distance
La programmation à distance permet d'utiliser, à travers le réseau, les fonctions offertes par le logiciel GS3100 Series Console. Pour gérer
les paramètres du Transmetteur, vous devez activer la programmation à distance grâce au logiciel GS3100 Series Console (voir le
paragraphe Programmation via PC->GPRS->Remote Programming), ou bien en envoyant un message SMS composé des
caractères “#UWS” suivis du Code Utilisateur et de “ON” compris entre les caractères * tel que selon la syntaxe suivante:

#UWS*Code Utilisateur*ON*

Pour désactiver la programmation à distance, envoyer le message SMS suivant:

#UWS*Code Utilisateur*OFF*
Un SMS confirmera si la commande a réussi.

Modification du Code Installateur
Le Code Installateur (maximum 4 caractères numériques) est utilisé en cas de besoin pour l'accès à l'interface de
programmation à distance (voir le paragraphe Programmation via PC->Codes->Installer Code). Le Code Installateur
réglé par défaut est ‘0002’, pour le remplacer, envoyer un message SMS composé des caractères “#CIC” suivis de l’ancien
Code Installateur et du nouveau Code Installateur compris entre les caractères * tel que selon la syntaxe suivante:

#CIC*Code Installateur*Nouveau Code Installateur*

Vous recevrez une confirmation par SMS si le Code Installateur a été modifié.
 Pour la composition du Code Installateur, seuls les chiffres de 0 à 9 peuvent être utilisés (maximum 4 chiffres).

Contrôle du crédit restant
Pour connaître le crédit restant au moyen d’un message SMS, il est possible de procéder par le biais du logiciel GS3100
Series Console (voir le paragraphe Programmation via PC->Options->Pay As You Go), ou bien à distance en envoyant
un message SMS composé des caractères “#CCC” suivis du caractère * tel que selon la syntaxe suivante:

#CCC*

 Le SMS de contrôle sera envoyé au 1er numéro du répertoire téléphonique.
NOTE - Le service de gestion du crédit des cartes SIM prépayées peut être suspendu selon la volonté de
l’opérateur du réseau GSM concerné.

PROGRAMMATION VIA PC
 Pour le bon fonctionnement de ce Transmetteur, utiliser une carte SIM de 32 K ou plus.

Cette Programmation via PC nécessite le câble PC-Link (non fourni), branché entre le Connecteur [9] du Transmetteur et un port Com du
PC (voir Fig.5) et l’application GS3100 Series Console. Pour le branchement, il est possible d’utiliser le câble PC-Link représenté sur la
Figure 5a ou bien le câble PC-Link représenté sur la Figure 5b. Attention au sens d’insertion du connecteur du câble PC-Link utilisé. Une
fois le branchement effectué, sélectionner le port COM utilisé à travers le champ situé dans le menu Options->Serial ports. En cas de
problèmes de communication, contrôler le branchement et le réglage du port en série ou bien utiliser un convertisseur USB-RS232 différent.
 Pour installer et exécuter l’application GS3100 Series Console, vous devez disposer des droits d’administration du

PC. Il est également conseillé de vérifier le pare-feu en cas de problème lors de l'installation de l'application.
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Lire la Programmation
Pour lire la programmation du Transmetteur et l’afficher sur le PC, sélectionner l’icône Upload from board.

Envoyer la Programmation
Une fois la Programmation pour un nouveau client effectuée (ou bien les réglages d’un client déjà chargé modifiés), envoyer
la programmation au Transmetteur en utilisant l’icône Download to board.

Opérations préliminaires
La fenêtre principale s’affiche à l’exécution de l’application; en haut à gauche de celle-ci, deux sections apparaissent en
sélectionnant par un click le champ Untitled #1.
 Dans la section des paramètres généraux vous trouverez les applications suivantes:

Customer informations: dans cette section il est possible d’afficher la série du Transmetteur (GS3105 ou
GS3125), ainsi que d’extraire et d’ajourner la configuration relative à un client avec la procédure suivante:
1. Cliquer avec le clic gauche sur l’application.
2. Insérer ou mettre à jour les données relatives au client et à l’installation. Confirmer avec la touche.
Upload from board: en sélectionnant  cette icône les données programmées sur la carte seront chargées sur le PC.
Download to board: en sélectionnant cette icône les données programmées seront envoyées à la carte. L'envoi
au dispositif de toute la programmation ou des pages "GPRS", "I/O" (seulement pour GS3125) et "Options"
(seulement pour GS3105) provoquera le redémarrage du Transmetteur.
Factory defaults: utilisez cette icône pour rétablir la configuration d’usine. Sachez que le rétablissement de la
configuration d’usine n’efface pas les messages vocaux enregistrés.
Board reset: la sélection de cette icône provoque la réinitialisation du Transmetteur.

 Dans la section commune à la série GS3105 et GS3125 vous trouverez les applications suivantes.

Phonebook: page relative au répertoire téléphonique.

Options: page des options.

GPRS: page des paramètres GPRS.

Status: page pour le contrôle du Transmetteur.

PTM: page pour régler les caractéristiques de la fonction PTM.

a b

Sens d'insertion du 
connecteur du câble PC-Link.

Sens d'insertion du 
connecteur du câble PC-Link.

RS-232

1 4

5

2
3

Côté
Soudures

1 4

Fig. 5 - Schéma du cordon de branchement PC-Link.
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Les pages suivantes sont disponibles uniquement pour le Transmetteur série GS3125.

I/O: les paramètres pour les sorties/entrées du transmetteur sont réglables depuis cette page.

Voice Dialer: page depuis laquelle il est possible de régler les paramètres relatifs à l’avertisseur vocal.

SMS Dialer: toutes les options de l’avertisseur SMS sont réglables depuis cette page.

Voice Message: page pour la gestion des messages vocaux.

Si vous souhaitez débuter la programmation pour un nouveau client, sélectionner le champ dans le menu File->New.
Pour afficher la Liste des Clients enregistrés dans l’archive, sélectionner le champ dans le menu File->Open. Dans cette
section il est possible d’éliminer ou de rappeler la configuration relative à un client avec la procédure suivante:
1. Cliquer avec le clic droit de la souris sur le nom désiré.

2. Sélectionner Load          pour charger les données de l’archive sur le Disque dur ou bien Delete selected customer
pour éliminer définitivement le client et toutes ses données de l’archive.
Pour charger un Client, il est également possible d’effectuer un double-clic sur son nom.
Vous pouvez également classer la liste par ordre alphabétique ou par codes avec un clic sur le titre de la colonne concernée.

Tous les paramètres à programmer sont recueillis dans les pages suivantes. La page (Status) sert au contrôle et à la gestion
du Transmetteur. Dans ce chapitre les pages présentes dans l’application sont décrites en détail.

Phonebook
Vous pouvez mémoriser dans cette page jusqu’à 100 numéros de téléphone.

 Le montant du crédit restant sur la carte prépayée est envoyé par SMS au numéro de téléphone #1.

 Description: insérer une séquence alphanumérique de 16 caractères maximum.
 Telephone number: saisir un numéro de téléphone précédé du préfixe international au format "+xxx" (exemple: +33

pour la France). Vous pouvez saisir un maximum de 16 chiffres (le caractère "+" compte comme un chiffre).
 Activates Output: sélectionner les numéros de téléphone qui peuvent activer les Sorties T1 (OC1), T2 (OC2) et T3

(OC3) lorsque le Transmetteur reçoit un appel de ceux-ci. Cette fonction ne dépend pas des options de White List ou
Black List (page Options->Dial Options). Pour l’activation de la sortie, le service d’identification de l’appelant doit être
activé (Calling Line IDentifier).

 Pour la série GS3105, seule la Sortie T3 (OC3) peut être activée.
 Pour l’activation de la sortie, sur la série GS3125, programmer les terminaux T1 (OC1), T2 (OC2) et T3 (OC3)

comme “Output” et activer “Reserved Output” (voir les pages I/O->Type et I/O->Reserved Output).
 Ouput Activation Confirmation: cette option est disponible uniquement pour la série GS3125, cochez cette case pour

obtenir une sonnerie de confirmation de l’activation effective de la sortie.
 ATTENTION:

— la sonnerie arrive 1 minute après l’activation de la sortie;
— si le Transmetteur est occupé par une opération (par exemple: le canal GSM est occupé par une
communication vocale), la sonnerie de confirmation n’est pas effectuée;
— l’option “Ouput Activation Confirmation” met fin à l’appel entrant après environ 5 s, même si l’option
“Black List” n’est pas activée.

 White List: le fait d’activer ou de désactiver   la case White List permet au Communicateur d’accepter ou de
refuser les appels en entrée. Le Transmetteur accepte les appels en entrée en les transférant aux dispositifs téléphoniques
reliés aux bornes LI (par exemple, une centrale antivol); ce qui est possible uniquement si LI fonctionne comme ligne
simulée par GSM. Le mode de fonctionnement de l’option White List est lié à la sélection  ou pas  de la case Black
List, présente dans la page Options->Dial Options, comme le montre le tableau suivant:

White List Black List Mode de fonctionnement

  Accepte les appels en entrée de n'importe quel numéro
  Refuse tous les appels en entrée

 
Accepte les appels en entrée seulement des numéros avec
l'option White List activée, refuse les appels provenant de
tous les autres numéros



GS3125/GS3105 19

FFFFF

Options
Cette page concerne le réglage des options relatives à la carte.

Dial options
Cette partie concerne l’insertion de certaines caractéristiques relatives aux numéros de téléphone.
 Prefix: le numéro inséré dans cette case est placé devant tous les numéros de téléphone appelés par le Transmetteur

en modalité Interface GSM. Taper le préfixe désiré (de 1 à 8 chiffres) ou bien laisser la case vide si elle n’est pas utilisée.
 Digits to Remove: si ce Transmetteur est branché en aval d’une centrale téléphonique, les numéros de téléphone (programmés sur la

centrale) doivent être précédés du numéro de la centrale (généralement un chiffre). Le numéro de la centrale n’étant pas nécessaire lorsque
les appels sont envoyés sur le réseau GSM, celui-ci doit être enlevé des chiffres qui forment le numéro de téléphone. Rentrer le nombre
de chiffres qui forment le numéro de la centrale (par ex: si le numéro du standard est 01, entrez 2 dans le champ “Digits to Remove”).

 Le numéro téléphonique doit avoir au moins deux chiffres en plus par rapport au numéro inséré dans le
champ “Digits to Remove” ou bien la tonalité occupé sera produite. Par exemple:
— le numéro de téléphone saisi est 0123, le nombre de chiffres à supprimer est 2 = correct, le numéro
composé restant est 23;
— le numéro de téléphone saisi est 123, le nombre de chiffres à supprimer est 2 = tonalité occupé, le numéro
composé restant est 3.

 Enable Black List: sélectionner cette option pour ne pas recevoir d’appels de la part des numéros de téléphone, autorisant
ainsi seulement ceux sélectionnés précédemment dans la White List (page Phonebook->White List).

 La fonction “Black List” seule met immédiatement fin à l’appel.
 La fonction “Black List” COMBINÉE à la fonction “Activates Output” sur reconnaissance de l’appelant donne

lieu à la fin de l’appel retardé de quelques secondes.
La sonnerie de confirmation associée à la fonction “Activates Output” sur reconnaissance de l’appelant
donne lieu à la fin de l’appel retardé de quelques secondes.
Si l’appel est tronqué immédiatement, l’action d’activation de la sortie n’a pas réussi.

Event priority (seulement pour la série GS3125)
Certaines priorités du Transmetteur peuvent être programmées sur cette page pour la transmission des évènements
d’alarme (voir le paragraphe Gestion des Priorités).
 Off-Hook: vous pouvez définir dans cette case la priorité des dispositifs téléphoniques branchés sur les bornes LI (par

exemple une centrale antivol). Par défaut  est activée, pour la désactiver il suffit de décocher le signe .
 Voice Dialer: vous pouvez définir dans cette case la priorité de l’Avertisseur vocal (messages vocaux). Par défaut 

est désactivée, pour l’activer il suffit de cocher avec .

Codes (seulement pour la série GS3125)
 User Code: le code utilisateur (maximum 4 caractères numériques) doit être saisi dans cette case pour l’activation à

distance des Sorties. Pour de plus amples informations, consulter le paragraphe “Activation des Sorties->Activation et
Désactivation des Sorties à distance”. Le code ‘0001’ est réglé par défaut.

 Installer Code: ce champ est réservé à la saisie du code installateur (maximum 4 caractères numériques). Ce code
permet, en cas de besoin, d'accéder à l'interface “Remote Programming”. Par défaut, le code réglé est ‘0002’.

Generic
Dans cette section vous pourrez régler les niveaux audio du haut-parleur et du microphone du Transmetteur GSM.
 Speaker volume: le volume du haut-parleur se règle en déplaçant le curseur.
 Microphone volume: le volume du microphone se règle en déplaçant le curseur.
 ATTENTION: le volume élevé du microphone pourrait corrompre les tonalités DTMF provenant des dispositifs

reliés aux bornes LI, les rendant ainsi méconnaissables.
 Tones...:  sélectionner le nom du pays d’installation du Communicateur; le pays sélectionné établit une série de

paramètres pour le fonctionnement correct de la ligne téléphonique simulée.
 LE failure timeout: entrez le temps en seconde (entre 10 et 3600 secondes) pour la coupure de la ligne sur les

terminaux LE avant l'événement Panne PSTN.
 En présence de dispositifs téléphoniques branchés aux bornes LI, le temps peut augmenter jusqu’à environ

60 secondes maximum.
 LE restore timeout: saisir le temps en secondes (de 30 à 3600 secondes) durant lequel la ligne téléphonique doit être

présente sur les bornes LE, avant que l'évènement Panne PSTN ne soit rétabli.
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System (seulement pour la série GS3125)
Cette partie concerne le Système.
 SIM Phone Number: entrez le numéro de téléphone de la carte SIM du Communicator (maximum 16 chiffres).
 Auto Clock Adjusting: en sélectionnant cette case le dispositif ajournera la date et l’heure de système en s’envoyant

automatiquement un SMS.
 SMS Service Center Address: option en lecture seule. Affiche le numéro du centre de service SMS sur la carte SIM.

Pay As You Go (seulement pour la série GS3125)
  Le service de gestion du crédit des cartes SIM prépayées peut être suspendu selon la volonté de l’opérateur

du réseau GSM concerné.
A travers cette section, un SMS comprenant les informations fournies par l’opérateur sur le crédit restant est envoyé périodiquement au premier
numéro du répertoire. Programmer les options suivantes afin de requérir correctement le crédit restant en fonction du type d’opérateur utilisé:
 Enquiry Type: choix du type de requête (SMS, Call, Service Command).
 Enquiry Number: numéro de téléphone à appeler ou auquel envoyer un SMS pour requérir l’information du crédit restant.
 Balance Message: chaîne utilisée à la fois pour l’envoi de SMS que pour les requêtes effectuées par le biais d’une

commande de réseau (Service Command).

 Interval: saisir dans cette case l’intervalle (HH-JJ) dans lequel envoyer un SMS Périodique avec les informations sur
le crédit restant (si pris en charge par l’opérateur téléphonique). L’intervalle est composé des valeurs suivantes:
— (HH) heure prochain envoi - Sélectionner la valeur pour l’envoi du SMS Périodique suivant. L’intervalle des valeurs
admissibles va de 0 à 23.
— (JJ) jour prochain envoi - Sélectionner la valeur pour l’envoi du SMS Périodique suivant. L’intervalle des valeurs
admissibles va de 0 à 365.

Outputs  (seulement pour la série GS3105)
Dans cette section, les modalités de fonctionnement des sorties sont réglables.
   Output 1, Output 2, Output 3: sélectionner la case pour le fonctionnement de la sortie “normalement fermée” ou

“normalement ouverte”.
  Output 3 ON Time: vous pouvez insérer dans ce champ le Temps ON en secondes (de 0 à 86400 secondes).

Primary Path
L’utilisateur peut programmer la ligne primaire de communication.
  Primary Path: sélectionner dans ce champ la ligne primaire GSM ou PSTN.

GPRS
Cette page concerne le réglage des paramètres relatifs au GPRS.
 Étant donnés les retards possibles de transmission sur GPRS liés aux activités du fournisseur de réseau, il est

conseillé de programmer un nombre de tentatives d’appel sur la centrale antivol le plus haut possible et de
prévoir éventuellement un numéro de téléphone de backup qui transmette les alarmes par GSM au lieu du GPRS.

Access Point Name 1 et Access Point Name 2
Cette information doit généralement être requise à l’opérateur qui fournit le service GPRS. Insérer dans cette case le nom du
service qui fournit l’adresse IP. Le Access Point Name 2 est considéré comme un paramètre de backup.
 ATTENTION: saisir le NPA correct pour les services WAP/GPRS autrement certaines fonctionnalités pourraient

être limitées (pour plus d'informations, adressez-vous à l'opérateur du centre de services).

Main Receiver, Local Port 1 et Alarm Port 1 IP address
Insérer dans cette case l’adresse IP du récepteur et le numéro du port. Pour les récepteurs SYSTEM III et SYSTEM II, insérer
l’adresse IP et le port présents dans la section Alarm Port.

Exemple pour les opérateurs Italiens

Options Vodafone Wind TIM

Enquiry Type Call Service Command SMS

Enquiry Number 404 40916

Balance Message *123# PRE CRE SIN
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Backup Receiver, Local Port 2 et Alarm Port 2 IP address
Cette case concerne l’insertion de la deuxième adresse IP du récepteur et du numéro du port, avec pour différence le statut
des paramètres, qui sont considérés comme récepteurs de backup. Le Transmetteur reconnaît cette case uniquement dans
le cas où les paramètres relatifs à Main Receiver, Local Port 1 et Alarm Port 1 ont été insérés. En outre, les cases Enable
supervision et Supervision time se réfèrent uniquement au récepteur principal (Main Receiver).

APN1 Username et Password, APN2 Username et Password
Pour certains opérateurs il est nécessaire d’insérer l’authentification de la communication. Vous devrez donc alors insérer dans ces champs
le Nom utilisateur et le Mot de passe relatif. Les APN2 Username et Password sont considérés comme des données de backup.

Telephone numbers to decode
Le Transmetteur permet de transmettre les événements au format Contact ID par le réseau GPRS, notamment aux panneaux
de commande qui ne prennent pas en charge cette méthode.
Pour ce faire, vous devez définir un numéro de téléphone (les numéros de téléphone peuvent être "virtuels" ou "réels") sur le
panneau de contrôle pour la communication des événements au format Contact ID (par ex. : vous pouvez définir la valeur 0123).
Vous devez ensuite entrer le même numéro de téléphone virtuel dans l'un de ces champs (quatre numéros de téléphone au
maximum peuvent être programmés pour cette fonction).
Lorsque le Transmetteur détecte un appel en provenance de l'un de ces numéros, il code automatiquement l'événement au
format numérique et le transfère par le réseau GPRS vers le récepteur défini (“Main Receiver” ou “Backup Receiver”).
 Le numéro de téléphone doit contenir au moins 2 chiffres.

Les options “Préfix” et “Digits to Remove” n'ont aucun effet sur les numéros de “Telephone numbers to decode”.
Les “Telephone numbers to decode” doivent correspondre aux numéros de téléphone définis pour le
panneau de contrôle.
Laissez ces champs vides si vous n'utilisez pas cette fonction.
Pour que cette fonction soit exécutée correctement, les options du "Main Receiver" et éventuellement celles du
"Backup Receiver" doivent être réglées.

DNIS
Insérer le code d’identification univoque (s’il est demandé).

Account code
Rentrer obligatoirement dans cette case le Code d’identification pour la communication avec les récepteurs SYSTEM III ou
SYSTEM II.

Enable Supervision
Pour activer la supervision, sélectionner cette case. L’option supervision est disponible UNIQUEMENT pour le récepteur
principal (Main Receiver). Les messages de supervision ne sont pas envoyés durant les appels vocaux (sur GSM).

Supervision time (sec)
Régler le temps de supervision. Il est possible de régler un Temps de Supervision de 5 seconde à 65535 secondes, avec
des écarts de 1 seconde.

Remote Programming (seulement pour la série GS3125)
Cette interface permet d'utiliser, à travers le réseau, les fonctions offertes par le logiciel GS3100 Series Console. Il est
possible de gérer à distance les paramètres du Transmetteur grâce à cette interface. Pour utiliser cette fonction, connectez-
vous à l’adresse http://www.dscreachme.com.
 Enabled: pour activer la programmation à distance, cliquer sur cette case afin de la cocher (par défaut cette configuration est activée).
 Encryption key: il est possible de régler la clé cryptographique afin que la programmation à distance soit protégée des

accès non autorisés. La clé cryptographique peut être constituée de 1 à 32 caractères hexadécimaux. La valeur par
défaut est 0 (la clé cryptographique n’est pas utilisée).

Status
Cette page permet de contrôler le temps réel de toutes les fonctions du Transmetteur.

 ATTENTION - Cette page est mise à jour toutes les 5 secondes.
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Status section
Les données les plus importantes du Module GSM sont reportées dans cette section. En plus du nom du gestionnaire du
Réseau GSM, le niveau du signal GSM est affiché dans l’écran virtuel (par le biais d’un indicateur).
Les voyants d’État du Transmetteur peuvent être allumées ou éteintes; ils sont de couleur VERT: fonctionnement correct; orsqu’ils
sont ROUGES, ils indiquent la présence d’un disfonctionnement ou d’une panne; si en revanche ils sont ORANGES, ils indiquent qu’une
communication est en cours. Les voyants des Récepteurs GPRS Principal (Main) et de Réserve (Backup) sont ORANGES lorsque
le dispositif est initialisé mais qu’il n’est PAS connecté, ou bien lorsqu’il est connecté mais qu’il n’est PAS encore initialisé.

PTM
Cette page concerne la “fonction PTM (Panel Transmission Monitoring - Contrôle Transmission Centrale)” qui permet au
dispositif de transférer les appels à travers le canal GSM au cas où la communication entre la centrale et le récepteur devait
échouer sur la ligne téléphonique PSTN.
 Le Transmetteur rétablit le mode normal après 5 minutes sur le réseau GSM.
La fonction PTM considère que la communication a échoué lorsque:
– Elle ne relève pas la composition du numéro, si l’option “Check Dialling” est activée (cela contrôle le fait qu’un numéro

de téléphone est effectivement composé).
– Elle ne relève pas la Kiss-off (le signal qui est envoyé par le récepteur au terme d’une communication d’évènements réussie).
 La fréquence du signal de kiss-off est de 1400 Hz.
Le contrôle est effectué sur tous les numéros, si la liste “Telephone Numbers” est vide, ou bien uniquement sur les
numéros présents dans la liste.
Les appels sont transférés sur le canal GSM lorsque le “Maximum Failure Number” programmé est atteint.
 Telephone Number: saisir les numéros de téléphone (jusqu’à un maximum de 4 numéros de téléphone) à appeler en

utilisant la fonction PTM. Par défaut ces champs sont vides. Si ces champs sont vides, tous les numéros composés par
la centrale seront contrôlés par la fonction PTM (Kiss-off attendu en fin de communication).

 Check Dialling: désactivé par défaut, s’il est activé il force à compter le nombre d’erreurs dues au décrochage et au
raccrochage (sans composer de numéro de téléphone) du dispositif téléphonique relié aux bornes LI comme erreur.

 Max Failures: saisir dans ce champ le nombre total des erreurs relevées par le Transmetteur au-delà duquel la fonction
PTM est activée. La fonction PTM est désactivée de série (le réglage d’usine est 0) ; définir une valeur comprise entre
1 et 4 pour activer la fonction PTM.

I/O (seulement pour la série GS3125)
Sur cette page les modalités Entrée ou Sortie, les évènements d’activation pour les Sorties, leur Polarité en veille (N.C. ou
N.A.), les Sorties Réservées, les Chaînes SMS d’Activation à distance pour les Sorties Réservées, peuvent être programmés.
 Type: il est possible de programmer dans cette colonne les bornes T1, T2 et T3 pour les modalités suivantes:

— Input: sélectionner cette modalité pour activer la borne correspondant comme Ligne d’Entrée. La sélection de cette
modalité active la colonne Service (voir plus bas).
— Output: sélectionner cette modalité pour activer la borne correspondant comme Sortie Open-Collector.

 ATTENTION - Ces réglages mettent à jour automatiquement également les paramètres dans les pages “SMS
dialer”, “Voice dialer” et “Phonebook”.

 Polarity: l’état de la sortie/entrée en veille peut être programmé dans cette case;
— Normalement Fermé        avec la Sortie/entrée en veille, la borne relative résulte en masse (négatif).
— Normalement Ouvert        avec la Sortie/entrée en veille, la borne relative résulte ouverte.
Cliquer sur la case en face de la colonne “Polarity” pour inverser le paramètre affiché à ce moment.

 Activation events: cliquer dans la colonne relative à l’évènement à programmer en face de la sortie relative. Le signe 
indique que face à cet évènement, la Sortie relative sera activée. Cliquer sur les cases pour insérer/enlever le signe .
 ATTENTION - La programmation des évènements associés à une sortie implique la désactivation de
certaines cases relatives à cette sortie.  Avant de pouvoir programmer, il est nécessaire de retirer les signes
 insérés dans les différentes cases.
— PSTN Fault: en cas de sélection, la sortie sera activée en cas d’absence de la ligne téléphonique.
— GSM Fault: en cas de sélection, la sortie sera activée en cas d’absence du réseau GSM.
— HB Fail: en cas de sélection, la sortie sera activée en cas d’absence du message de supervision.
— FTC Signal: en cas de sélection, la sortie sera activée si la communication avec le récepteur échoue.
 La sélection de l’évènement “FTC Signal” permet de sélectionner l’option “Monostable” et le “Monostable Time”.
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 Reserved Output: lorsque cette option est sélectionnée, tous les autres évènements sélectionnés pour activer la
Sortie correspondante sont ignorés. Cocher la case correspondant à la Sortie à activer par le biais de la reconnaissance
d’appel ou par le biais de la commande SMS. Pour l’activation de la sortie sur reconnaissance de l’appelant,
programmer le numéro de téléphone sur la page “Phonebook” et activer l’option “Activates Output” (voir la page
Phonebook->Activates Output).

 Service: un signe  dans cette colonne indique que le Transmetteur est mis en État de SERVICE et c’est-à-dire qu’en présence
des évènements de déséquilibre sur les Lignes d’Entrée 1 et 2, au lieu d’effectuer un appel, le Transmetteur effectuera de façon
autonome une action déterminée. Pour chaque Ligne, il est possible de définir une action selon le tableau suivant. Dans tous
les cas, en sélectionnant ces actions aucun message SMS n’est envoyé par rapport aux Entrées 1 et 2.

  ATTENTION - Ces réglages mettent à jour automatiquement également les paramètres dans les pages
“SMS dialer”, “Voice dialer” et “Phonebook”.

 Control String: saisir dans cette colonne la chaîne (maximum 16 caractères alphanumériques) qui doit être envoyée
pour activer/désactiver la Sortie correspondante, à distance, par SMS. Cette fonction est disponible même si la
reconnaissance de l'appel n'est pas activée.

 Activation Confirmation: le type de
confirmation que vous souhaitez avoir lorsque
la Sortie sera activée doit être sélectionné dans
cette colonne. Il est possible de choisir parmi
3 valeurs différentes: Aucune (None), Sonnerie
(Ring) ou bien SMS (cette valeur n’est pas
disponible si la case “Control string” est
laissée vide). Si la sortie est activée par le
biais de l’envoi d’un SMS, la confirmation
d’activation de la sortie est transférée par SMS.

 Monostable: normalement les Sorties, lorsqu’elles
sont activées, restent en état d’activation jusqu’à
la commande successive de désactivation,
après laquelle la Sortie revient en état de veille.
Si vous souhaitez que la Sortie, une fois activée,
revienne automatiquement en état de veille après
un temps déterminé, sélectionner cette option et en régler le temps d’activation dans la case “Monostable Time (sec)” voisine.

 Monostable Time (sec): dans cette case, il est possible de saisir une valeur en secondes (de 1 à 86400 avec un écart
d’1 seconde) qui indique le temps durant lequel la Sortie, si elle est réglée comme Monostable, reste active avant de
revenir en état de veille (ON time).

Voice Dialer (seulement pour la série GS3125)
Dans cette section, il est possible de programmer tous les paramètres relatifs à l’avertisseur vocal et c’est-à-dire: les
numéros de téléphone à appeler (les 8 premiers numéros du répertoire téléphonique), le nombre de répétitions pour chaque
message (minimum 1, maximum 8), la durée et le nombre de messages selon ce qui est spécifié ci-dessous:
 Description: les évènements pour lesquels il est possible de programmer un message vocal sont décrits dans cette colonne.
 Pour sélectionner les messages vocaux pour les 3 Lignes d’Entrée programmables, régler la borne
correspondante comme Entrée (voir page I/O->Type).

 Telephone numbers: cliquer sur les colonnes ‘12345678’ en face de l’évènement désiré. Le signe  indiquera que ce
numéro de téléphone sera appelé lorsqu’un évènement sera vérifié. Cliquer sur les cases pour insérer/enlever le signe .
   Les numéros de téléphone sont les 8 premiers programmés dans la page “Phonebook”.

 Voice Message: triple-cliquer sur la colonne ‘Message’ en face de l’évènement désiré, puis cliquer sur le bouoton pour
faire défiler la liste des messages (il est possible de sélectionner, s’ils sont enregistrés, jusqu’à 8 messages d’une durée
maximum de 16 secondes chacun) et en sélectionner un. Jusqu’à 3 messages vocaux peuvent être liés à chaque
évènement (Message #1, Message #2, Message #3).

Ligne Entrée n. Sélection Fonction de Service associée

1 A Commutation forcée sur réseau GSM

2 B Eliminer Queue Téléphonique

Tableau des effets sur Activation de la Sortie

PROGRAMMATION EFFETS

Black List White List Activation
Confirmation

Appel Transféré Sonnerie
Confirmation

None OUI NON

Ring NON OUI

None OUI NON

Ring NON OUI

None NON NON

Ring NON OUI
None OUI NON

Ring NON OUI
Activé
Désactivé

(seul le Transmetteur est
commuté sur réseau GSM)
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 Repeat Call: il est possible d’insérer dans ce champ le nombre de tentatives à effectuer (jusqu’à un maximum de 8 fois)
si l’appel ne réussit pas.

 Repeat Message: il est possible d’insérer dans ce champ le nombre de répétitions du message vocal (jusqu’à un
maximum de 8 fois) à la réponse du numéro appelé.

 Call All Numbers: sélectionner cette option  pour appeler tous les numéros de téléphone programmés par évènement
puis reproduire le message vocal attribué. Si cette option n’est pas sélectionnée , l’avertisseur mettra fin aux appels
vocaux dès que l’un d’eux réussira.

 Call Confirmation: sélectionner cette option pour faire en sorte que l’avertisseur attende la confirmation de la part de l’utilisateur
à distance de la bonne réception du message vocal, sinon l’avertisseur tentera à nouveau de délivrer le message vocal: l’utilisateur
à distance peut envoyer la confirmation en appuyant sur la touche  de son téléphone (uniquement pour les téléphones à touches).

 ATTENTION - Durant l’écoute d’un message vocal, en appuyant sur la touche  sur le clavier de votre
téléphone, il est possible de bloquer à la  fois l’appel en cours et tous ceux éventuellement en cours.
 Dans certains cas, l'avertisseur peut mal interpréter la réponse des répondeurs, messages de bienvenue
de l'opérateur GSM, etc., il est donc conseillé d'activer la "Call Confirmation".

Periodic voice
Dans cette section, les options relatives à l’envoi du Message Vocal Périodique peuvent être programmées.
 Vous DEVEZ introduire le “SIM Phone Number” et activer la fonction “Auto Clock Adjusting” à la page

“Options” pour configurer les options du Message Vocal Périodique.
 Date of first send: sélectionner la date pour l’envoi du premier Message Vocal Périodique.
 Time of first send: sélectionner l’heure pour l’envoi du premier Message Vocal Périodique.
 Interval: saisir dans ces cases l’intervalle (HH-JJ) dans lequel envoyer les Messages Vocaux Périodiques suivants.

L’intervalle est composé des valeurs suivantes:
— (HH) heure prochain envoi - Sélectionner la valeur pour l’envoi du Message Vocal Périodique suivant. L’intervalle des
valeurs admissibles va de 0 à 23.
— (JJ) jour prochain envoi - Sélectionner la valeur pour l’envoi du Message Vocal Périodique suivant. L’intervalle des
valeurs admissibles va de 0 à 365.

 Update time: il est possible d’obtenir la date et l’heure depuis le PC en sélectionnant cette icône.

Local Service Mode
Le bouton Local service mode, vous pouvez activer la lecture ou l'enregistrement des messages vocaux à partir d'un
téléphone à touche relié aux terminaux [LI] de l'appareil (v. “Enregistrement local des Messages Vocaux” et “Reproduction
locale des Messages Vocaux”). Lorsque cette modalité est activée, les LED Vertes L1 et L2 clignotent (voir Led de
contrôle->tableau 2). Le clignotement des LED prend fin uniquement au terme de la procédure d’enregistrement ou de
reproduction ou bien après que 60 secondes se soient écoulées sans appuyer sur aucune touche.
 Vous ne pouvez relier qu'un seul téléphone aux terminaux [LI] pour un fonctionnement optimal du “Local Service Mode”.

SMS dialer (seulement pour la série GS3125)
Cette page permet de définir les options du numéroteur SMS, selon les indications ci-dessous.
 Event Type: dans la colonne ‘Event Type’ sont reportés, pour chacune des 11 lignes, les évènements en présence

desquels, si cela est programmé, l’envoi de deux SMS est prévu: un d’activation, l’autre de rétablissement (pour
l’évènement ‘Periodic SMS’ l’envoi d’un seul Message SMS d’activation est prévu).
 Pour sélectionner les messages SMS pour les 3 Lignes d’Entrée programmables, régler la borne
correspondante comme Entrée (voir le paragraphe I/O->Type).

 Telephone numbers: cliquer sur les colonnes ‘12345678’ en face de l’entrée désirée. Le signe  indiquera que le
message SMS sera envoyé à ce numéro de téléphone lorsque l’évènement correspondant se vérifiera.
 Les numéros de téléphone sont les 8 premiers programmés dans la page “Phonebook”.

 SMS String: dans la colonne ‘SMS String’, cliquer sur la case correspondant au message à programmer et saisir le
message à envoyer lorsque l’évènement correspondant se vérifiera (maximum 100 caractères).

Periodic SMS
Dans cette section, les options relatives à l’envoi du SMS Périodique peuvent être programmées.
 Vous DEVEZ introduire le “SIM Phone Number” et activer la fonction “Auto Clock Adjusting” à la page

“Options” pour configurer les options SMS périodiques.
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 Date of First Send: sélectionner la date pour l’envoi du premier SMS Périodique.
 Time of First Send: sélectionner l’heure pour l’envoi du premier SMS Périodique.
 Interval: saisir dans ces cases l’intervalle (HH-JJ) dans lequel envoyer les SMS Périodiques suivants. L’intervalle est

composé des valeurs suivantes:
— (HH) heure prochain envoi - Sélectionner la valeur pour l’envoi du SMS Périodique suivant. L’intervalle des valeurs
admissibles va de 0 à 23.
— (JJ) jour prochain envoi - Sélectionner la valeur pour l’envoi du SMS Périodique suivant. L’intervalle des valeurs
admissibles va de 0 à 365.

 Update time: il est possible d’obtenir la date et l’heure depuis le PC en sélectionnant cette icône.

Voice Message (seulement pour la série GS3125)
Cette page permet aussi d'enregistrer et de lire les messages vocaux. Consultez la page “Voice Dialer” pour l'association
des messages aux événements. Pour ouvrir l’archive des messages vocaux, cliquer sur l’icône à gauche du bouton
RECORD, à droite du champ “WAV File#1”.
 Le Transmetteur supporte uniquement les fichiers audio WAWE (.WAV), d’une durée maximum de 16

secondes, ayant les caractéristiques suivantes: PCM, 8000 Hz, Mono, non compressé. Vous pouvez utiliser
des fichiers pré-enregistrés qui respectent le format indiqué.

Bouton PLAY - Appuyer sur ce bouton pour réécouter le message vocal.

Bouton RECORD - Appuyer sur ce bouton pour démarrer l’enregistrement d’un nouveau message vocal.

Bouton STOP - Appuyer sur ce bouton pour arrêter la reproduction ou l’enregistrement en cours du message vocal.

Bouton GET - Appuyer sur ce bouton pour charger le message vocal enregistré.

Bouton SET - Appuyer sur ce bouton pour envoyer au Transmetteur le message vocal enregistré.

Bouton ERASE - Appuyer sur ce bouton pour éliminer directement le message vocal présent sur le Transmetteur.

Durant l’enregistrement du message, une barre d’avancement indique, en temps réel, le temps passé.

Enregistrement local des Messages Vocaux
 Vous ne pouvez relier qu'un seul téléphone aux terminaux [LI] pour un enregistrement optimal du message vocal local.
Pour enregistrer un message vocal à partir d'un téléphone à touches relié aux terminaux [LI], activez Local Service Mode
dans le volet Voice Dialer et procédez comme suit:
1. Appuyer sur la touche ;

2. Appuyer dans l’ordre sur les touches  pour entrer dans la modalité d’enregistrement;

3. Saisir le numéro du message que vous souhaitez enregistrer (de  à );
4. Après le Bip, enregistrer le message vocal (la durée maximum du message vocal est de 16 secondes).
5. Appuyer sur la touche  pour confirmer l’enregistrement du message (ou bien appuyer encore sur la touche  pour

interrompre plus tôt l’enregistrement du message), un ton Boop sera émis.
A partir de ce moment, tout enregistrement effectué précédemment pour ce message sera ELIMINE.

6. Si vous devez enregistrer d’autres messages, répéter la procédure depuis le point 1.

Reproduction locale des Messages Vocaux
 Vous ne pouvez relier qu'un seul téléphone aux terminaux [LI] pour une lecture optimale du message vocal local.
Pour lire un message vocal à partir d'un téléphone à touches relié aux terminaux [LI], activez Local Service Mode dans
le volet Voice Dialer et procédez comme suit:
1. Appuyer sur la touche ;

2. Appuyer dans l’ordre sur les touches  pour entrer dans la modalité de reproduction;

3. Saisir le numéro du message que vous souhaitez écouter (de  à );



26 Transmetteur d'alarme GSM/GPRS

4. Après le Bip le message est reproduit puis un Boop de confirmation est émis (appuyer sur la touche  pour interrompre
d’avance la reproduction du message);

5. Si vous devez écouter d’autres messages, répéter la procédure depuis le point 1.

Programmation optionnelle Antisabotage
Le branchement (voir le paragraphe Branchements->Branchements Auxiliaires) du Déviateur Antisabotage MAXIASNC
(optionnel) permet de détecter les éventuelles tentatives de violation du couvercle du Transmetteur. Pour envoyer un
message SMS et/ou vocal à un ou plusieurs numéros de téléphone programmés lorsque le couvercle du Transmetteur est
retiré, effectuer, par le biais du logiciel GS3100 Series Console, la programmation suivante:
1) Dans la page Phonebook, programmer les numéros de téléphone auxquels envoyer le message d'alarme.
2) Dans la page I/O, programmer la borne T3 dans la colonne Type comme Entrée et dans la case Polarity l'état de l'entrée au repos

comme Normalement Ouverte NO (la configuration au repos du Déviateur Antisabotage est du type Normalement Fermée NC).
3) Dans la page SMS dialer et/ou Voice dialer, programmer pour Input 3 Event, tant bien le message SMS et/ou vocal

que les numéros de téléphone auxquels envoyer le message.

PASS-THROUGH (SEULEMENT POUR LA SÉRIE GS3125)
Cette fonction permet à la centrale Serie Power PC1864 (versions  PC 1864 4.1 EU, PC 1864 4.2 EU, PC 1864 4.2 ADT
Spain, PC 1864 4.5 ADT Spain, PC 1864 4.5 EU) d’être programmée à distance par GPRS à l’aide du Transmetteur
GS3125 et le logiciel DLS IV INT doté du pilote pour “driver pack for the GS3125”. Le Transmetteur doit être programmé
avant d’être branché sur la centrale Serie Power PC1864.

Programmation du Transmetteur
Pour programmer le Transmetteur, v. le paragraphe “Programmation via PC”. A l’aide de l’application GS3100 Series
Console, effectuez les réglages suivants :
1. Activer la programmation à distance sur le Transmetteur (v. le paragraphe “GPRS->Remote programming”).
2. Programmer sur le Transmetteur un nom de point d’accès (APN) valable (v. paragraphe GPRS).

Raccordement du Transmetteur à la centrale Serie Power PC1864
Pour raccorder la centrale Serie Power PC1864 aux Transmetteur GS3125, il faudra utiliser le câble PCLINK-PCLINK (v. fig. 6)
reliant la prise PC-Link [9] du Transmetteur et la prise PC-Link de la centrale en faisant attention au sens d’insertion de la prise.

 ATTENTION : brancher le câble PCLINK-PCLINK conformément à la fig. 6. Le fil  de la prise du câble
PCLINK-PCLINK doit être relié à la borne 4 de la prise PC-Link du Comunicateur et de la centrale.

PC-LINK

PC1864

GS3125

Fig.6 - Raccordement du Communicateur à la centrale DSC Serie Power par câble PCLINK-PCLINK.
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Opérations nécessaires sur la centrale Serie Power PC1864
Effectuer les contrôles suivants sur la centrale Serie Power PC1864 :
1. Contrôler la section 382 de la centrale : l’option 5 doit être réglée sur ON.
2. Il ne doit pas y avoir de panne et le témoin VERT de la centrale doit être ALLUME. Cela indique que la centrale reconnaît

le Transmetteur GS3125, qu’il est bien connecté et fonctionne correctement.

Opérations à effectuer sur le PC
Effectuer les opérations suivantes sur le PC avant la programmation à distance à l’aide de l’application DLS IV INT :
1. Le PC doit avoir une adresse IP publique et un port public pour les connexions en entrée à partir de l’application DLS IV INT.
2. Le pare-feu et le routeur doivent permettre la connexion du port public au port 51004 de l’application DLS IV INT.
3. Vérifier s’il est possible d’accéder au port public du routeur à parti d’un autre PC pour vérifier si le logiciel DLS IV INT peut

être contacté par le dispositif.

Programmation à distance à l’aide du logiciel DLS IV INT
Pour programmer la centrale à distance, il faut avoir installé le logiciel DLS IV INT et le pilote mis à jour à partir du site DSC.

 ATTENTION : pour pouvoir obtenir de l’aide sur DLS IV INT pour GS3125, il faut installer les “driver pack for the GS3125”.

Avant de lancer la connexion à distance par GPRS entre le Transmetteur et l’application DLS IV INT, il faut envoyer un message
SMS à l’aide d’un téléphone GSM au Transmetteur. Il est dès lors nécessaire de connaître le numéro de téléphone affecté à la carte
SIM. Dans la fenêtre “SMS Message Generator” du logiciel DLS IV INT, les données suivantes sont visibles. Elles permettent la
création du texte du message SMS à envoyer au Transmetteur. Pour afficher cette fenêtre, effectuez les étapes suivantes :
1. Lancer l’application DLS IV INT sur votre PC.
2. Créer un “New Account” en insérant le type de centrale (par ex. : PC1864 v4.2 EU) et le “Connection Type”, par ex.

“SMS (GS GS3125)”.
3. Introduire les informations nécessaires et cliquer sur “Create”.
4. Accéder à la rubrique GS/IP du menu et insérer le code installateur dans le champ “GS/IP Installers Code” (max. 4 caractères

numériques, v. le paragraphe “Programmation via PC->Options->Codes->Installer Code”) et “IMEI” du Transmetteur.
5. Cliquer, par ex., sur l’icône “Global Upload” et choisir la valeur SMS comme “Connection Type”. Cliquer ensuite sur “OK”.
6. La fenêtre “SMS Message Generator” s’affiche. Elle contient les informations nécessaires à la création du texte du

message SMS (par ex. : #DLS#11122233344451004).
7. Dans la fenêtre “SMS Message Generator”, cliquer sur “OK”. L’application DLS IV INT attend la liaison avec le Transmetteur.
8. Envoyer le message SMS au Transmetteur à l’aide du téléphone GSM.
9. Après avoir reçu le message SMS, si celui-ci est correct, le Transmetteur lance la connexion à distance par GPRS avec

l’application DLS IV INT. Elle permet désormais de communiquer à distance par GPRS avec les centrales Serie Power PC1864.

Fig.7 - Programmation à distance à l'aide du logiciel DLS IV INT.

2. L'opérateur entre
le message SMS sur son
téléphone en copiant
les informations affichées.

3. Le message SMS contenant
l'IP publique et le port du DLS
est envoyé au GS3125.

 

5. 

.

DLS communique avec
la centrale DSC (options
Upload/Download) par le biais
du GS3125

4.Le GS3125 se 
connecte au DLS par
GPRS

1a.

2a.

 L'opérateur lance une session
de communication DLS par GPRS.

 DLS affiche les informations
à utiliser pour le message SMS.

Centrale DSC
Série Power



28 Comunicatori di Allarme GSM/GPRS

Per programmare questo dispositivo utilizzare il software GS3100 Series Console ver. 3.0 o superiore.
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Informazioni sul riciclaggio
DSC consiglia ai clienti di smaltire i dispositivi usati (centrali, rilevatori, sirene, accessori elettronici, ecc.) nel rispetto dell'ambiente. Metodi

potenziali comprendono il riutilizzo di parti o di prodotti interi e il riciclaggio di prodotti, componenti e/o materiali.
Per maggiori informazioni visitare http://www.dsc.com

Direttiva Rifiuti di apparecchiature elettriche ed  elettroniche (RAEE – WEEE)
 Nell'Unione Europea, questa etichetta indica che questo prodotto NON deve essere smaltito insieme ai rifiuti domestici.

Deve essere depositato in un impianto adeguato che sia in grado di eseguire operazioni di recupero e riciclaggio.
Per maggiori informazioni visitare http://www.dsc.com

Con la presente, DSC (Digital Security Controls) dichiara che la
serie GS3105 e GS3125

è conforme ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE. Le dichiarazioni di conformità complete possono
essere trovate all’indirizzo: www.dsc.com

I seguenti modelli sono stati certificati da Telefication essere conformi alle EN 50136-1-1 e EN 50136-2-1 con prestazioni del Sistema di Trasmissione
Allarme ATS 2 (D2, M2, T2, S0, I0): GS3105-K, GS3125-K, GS3105-BA e GS3125-BA.

 L’installazione di queste apparecchiature deve essere effettuata a regola d’arte, in accordo con le norme vigenti. Queste apparecchiature sono state
sviluppate secondo criteri di qualità, affidabilità e prestazioni adottati dalla DSC. Si raccomanda di verificare il corretto funzionamento del sistema

almeno una volta al mese. Le procedure per il collaudo dipendono dalla configurazione del sistema. Chiedere all’installatore del sistema le procedure
da seguire. DSC declina ogni responsabilità nel caso in cui le apparecchiature vengano manomesse da personale non autorizzato.

Il contenuto di questo manuale può essere soggetto a modifiche senza preavviso e non rappresenta un impegno da parte della DSC.
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INTRODUZIONE
I dispositivi della serie GS3105 e GS3125 sono dei comunicatori GSM che in mancanza di linea PSTN inviano allarmi vocali
e digitali, tramite GPRS, ai ricevitori System III o System II. Sono disponibili le seguenti versioni:
— GS3105-K e GS3125-K kit comprensivo di scheda comunicatore GSM/GPRS, antenna con cavo da 2 m, staffa metallica

e cavo PCLINK-PCLINK;
— GS3105-BA e GS3125-BA kit comprensivo di scheda comunicatore GSM/GPRS, antenna con cavo da 25 cm,

contenitore e cavo PCLINK-PCLINK;
— GS3100-BX kit comprensivo di antenna con cavo da 25 cm e contenitore.
Le informazioni che riguardano una specifica versione saranno evidenziate facendo riferimento al codice corrispondente. Il termine
“Comunicatore” sarà utilizzato per descrivere le funzioni comuni alle diverse versioni. Questo manuale fornisce le istruzioni per la
programmazione e l’uso del Comunicatore. Per particolari esigenze di installazione sono disponibili l’antenna remota da esterno ANT-EU.
 Questo Comunicatore deve essere installato solo da Personale Qualificato (una Persona Qualificata ha la preparazio-

ne tecnica appropriata e l'esperienza necessaria per essere consapevole, dei pericoli ai quali può essere esposta
durante lo  svolgimento di un lavoro, e delle misure per minimizzare i rischi per se stessa e per le altre persone).
Questo Comunicatore deve essere installato e usato solo in ambienti con Grado di Inquinamento massimo 2,
Categoria di Sovratensioni II, in luoghi non pericolosi, al chiuso. Queste istruzioni devono essere usate insieme al
manuale di installazione della centrale. Tutte le istruzioni presenti in questo manuale devono essere osservate.

Caratteristiche Generali
 Fornisce una linea PSTN simulata
 Rilevamento assenza linea PSTN e commutazione au-

tomatica su Rete GSM
 Gestione e segnalazione delle telefonate in entrata ed in uscita
 Indicatore di intensità del campo GSM
 3 Morsetti programmabili come Uscite Open-Collector o

come Linee d’Ingresso (solo serie GS3125)
 Protezione da sovratensioni sulla linea telefonica
 GSM Quad-Band
 Antenna con base magnetica
 Avvisatore SMS (solo serie GS3125)
 Avvisatore Vocale (solo serie GS3125)
 Decodifica del Protocollo Contact ID ed invio dei dati via GPRS
 Comunicazione GPRS/Internet con ricevitori Sur-Gard

System III/II
 Opzioni programmabili da PC

 Funzione Pass-through per il collegamento con le Cen-
trali DSC Serie Power PC1864 (solo serie GS3125).

 11 Messaggi SMS, ognuno con lunghezza massima di 100
caratteri (2  per ogni Linea di Ingresso più 4 per le Segnalazioni
di Stato e 1 Periodico), solo per la serie GS3125

 8 numeri telefonici (max. 16 cifre) programmabili per
l’Avvisatore SMS (solo serie GS3125)

 4 numeri telefonici programmabili per l’Avvisatore
Contact ID su GPRS

 Fino a 100 numeri telefonici (max.16 cifre) programmabili
per l’attivazione da remoto dell’Uscita OC

 Attivazione delle uscite da remoto mediante riconosci-
mento del chiamante, e/o l’invio di SMS (invio di SMS
solo per la serie GS3125)

 Controllo credito residuo delle SIM-CARD prepagate (solo
serie GS3125)

 (PTM) monitoraggio delle comunicazioni con la centrale

Caratteristiche Tecniche
La tensione di alimentazione per questo Comunicatore è fornita dalla Centrale oppure da un alimentatore stabilizzato (non fornito).

Versione GS3105-K, GS3125-K GS3105-BA, GS3125-BA
Tensione di alimentazione da 10 a 27,6 V_
Corrente a riposo 100 mA massimo (escluse le uscite) a 13,8 Vcc
Corrente massima in allarme (trasmissione) 250 mA valore medio (escluse le uscite) a 13,8 Vcc
Uscite OC 3 open collector, da 100 mA
Frequenza di funzionamento 900/1800 MHz oppure 850/1900 MHz
Massima resistenza in serie
per linea dei dispositivi collegati ai morsetti LI

1 Kohm

Numero massimo di dispositivi
collegabili in parallelo ai morsetti LI

1

Temperatura di funzionamento 5 ÷ 40 °C

Dimensioni (LxHxP)
60,5x142x15,3 mm

(solo PCB)
90x190x75 mm
(senza antenna)

Peso 66 g 348 g
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Descrizione Generale
Il Comunicatore può comunicare con le Centrali di Vigilanza e, solo per la serie GS3125, inviare messaggi sia SMS che
vocali; inoltre, può simulare la linea telefonica PSTN in caso di guasto (mancanza della linea telefonica) o sostituirsi
completamente ad essa in quelle aree raggiunte dal servizio GSM e nelle quali la linea telefonica PSTN non è disponibile.
È in grado di comunicare eventi di allarme tramite la rete GPRS, consentendo una comunicazione affidabile e veloce con
centrali di vigilanza dotate di un ricevitore Sur-Gard System III o System II. Le prestazioni di questo Comunicatore dipendono
fortemente dalla copertura della rete GSM, quindi, esso non dovrebbe essere installato prima di aver eseguito una prova di
posizionamento dell’antenna per determinare il luogo migliore di ricezione (almeno 1 LED verde deve essere acceso).
I Comunicatori della serie GS3105 sono dotati di 3 uscite di cui 1 può essere attivata/disattivata da remoto mentre le altre
2 usate per segnalazioni di: problema su linea telefonica PSTN; problema su rete GSM.
I Comunicatori della serie GS3125 sono dotati invece di 3 morsetti programmabili come:
– Uscite (impostazione di fabbrica) che possono essere attivate/disattivate da remoto o usate per le segnalazioni di stato:
problema su linea telefonica PSTN; problema su rete GSM; Supervisione Fallita; Comunicazione Fallita (FTC).
– Linee d’Ingresso per l’attivazione dell’Avvisatore Vocale e dell’Avvisatore SMS che possono essere utilizzati anche per
inviare segnalazioni di stato.
A causa delle caratteristiche della rete GSM, questo Comunicatore deve essere usato esclusivamente per gli scopi
previsti, e NON può essere usato come modem per la trasmissione di fax e dati o per operazioni di Teleassistenza.

IDENTIFICAZIONE DELLE PARTI
I numeri fra parentesi quadre [  ] in questo manuale, fanno riferimento alle parti principali di questo Comunicatore mostrate in Figura 1.

INSTALLAZIONE
 NON passare alcun filo sopra la scheda elettronica.
 Questo Comunicatore deve essere installato solo da PERSONALE QUALIFICATO, al chiuso in un luogo sicuro

e asciutto, lontano da apparecchi radio-trasmittenti.
 Scegliere la posizione di installazione di questo Comunicatore per garantire una buona copertura del segnale GSM.

GS3105-K o GS3125-K
 Questo Comunicatore è composto da una scheda destinata ad essere posizionata all’interno di una centrale antifurto,

preferibilmente con contenitore metallico, e da un’antenna che si collega alla scheda tramite cavo coassiale. Durante
il normale funzionamento questi elementi (scheda, antenna e cavo) possono essere fonte di campi elettromagnetici
irradiati e, se nelle vicinanze sono presenti dispositvi elettronici non sufficientemente immuni a tali campi, possono
verificarsi interazioni indesiderate. A tale scopo si consiglia di posizionare la scheda il più lontano possibile da tali
dispositivi elettronici suscettibili e l’antenna sulla superficie esterna del contenitore metallico o lontana da esso tramite
l’apposita staffa. Per il cavo coassiale di collegamento si consiglia di lasciare all’interno del contenitore metallico della
centrale la lunghezza minima necessaria e di sistemare l’eventuale eccedenza all’esterno del contenitore metallico.

1. Svitare le viti e rimuovere il coperchio della centrale.
2. Individuare all’interno del contenitore metallico della centrale un’area in grado di ospitare la scheda, incluso il cablaggio.
3. Posizionare i 4 supporti plastici adesivi [14] sul fondo del contenitore metallico, quindi inserire i fori [7] presenti sulla

Scheda Elettronica nei supporti plastici adesivi, come mostrato in Figura 2.
4. Montare l’antenna [1] all’esterno del contenitore.
4a. Posizionare l’antenna [1] sopra il contenitore metallico (Fig.2) in maniera che la base magnetica [2] aderisca con la

superficie. Passare il cavetto dell’antenna attraverso un’apertura per il passaggio cavi. Se necessario è possibile
utilizzare la staffa metallica [13], vedere la Fig.2a. Fissare la staffa metallica [13] utilizzando i fori [12] su di un supporto
adeguato. Posizionare l’antenna [1] sopra la staffa metallica [13] (Fig.2a), in maniera che la base magnetica [2] aderisca
con la superficie. Passare il cavetto dell’antenna attraverso il foro [11] della staffa metallica [13].

5. Collegare il cavetto [3] al connettore per antenna GSM [4].
6. Eseguire i collegamenti sulle morsettiere [10].
7. Inserire la SIM-CARD [8] nel porta-SIM [6], come indicato dalla freccia, con i contatti verso il basso (vedere la Figura 1).
!!!!! Il PIN della SIM-CARD deve essere disabilitato prima del suo inserimento nel Comunicatore.
!!!!! Si consiglia di disabilitare sulla propria SIM-CARD il trasferimento di chiamata.

8. Controllare all’accensione che tutti i LED verdi lampeggino, in questo stato il dispositivo si trova nella fase di inizializzazione.
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9. Controllare l’intensità del segnale:
– assicurarsi che almeno un LED verde si accenda; tutti i LED verdi accesi indicano una copertura ottimale;
– se i LED verdi sono spenti, l’intensità del segnale NON è sufficiente; cambiare la posizione dell’antenna fino a
quando non si ottiene un’intensità accettabile, almeno un LED verde acceso.

10. Chiudere il coperchio della Centrale.
 Collegare l’alimentazione e i circuiti telefonici solo dopo che il Comunicatore è stato fissato ed è stato

collegato al circuito di terra dell’edificio.
!!!!!  Prima di inserire o rimuovere la SIM CARD, assicurarsi che il Comunicatore NON sia alimentato.

ANT-EU Antenna remota
Per il montaggio dell’antenna remota ANT-EU da esterno fare riferimento alle istruzioni fornite con il prodotto. L’ANT-EU è utile
per fornire al Comunicatore un campo GSM di maggiore intensità.

GS3105-BA, GS3125-BA o GS3100-BX
Vedere figura 1.
1. Segnare la posizione dei fori [19] per il fissaggio a muro del fondo metallico [17].
2. Praticare sul muro i fori nei punti segnati.
3. Inserire i 4 supporti scheda [16] nei fori sul fondo metallico [27].
4. Passare i cavi per i collegamenti attraverso l’apertura sul fondo [22].
5. Fissare il fondo metallico al muro tramite i tasselli (non forniti).
!!!!! Fare attenzione a non danneggiare fili o tubazioni sottotraccia.

6. Posizionare la Scheda Elettronica (non fornita con le versioni GS3100-BX) sui Supporti [16] e spingerla verso il fondo fino
a bloccarla in posizione, come mostrato in Figura 1.

7. Collegare il cavo dell’antenna [3] al connettore sulla Scheda Elettronica [4].
8. Passare il cavo dell’antenna [3] sotto la linguetta fermacavo [26], quindi attraverso l’apertura [23].
9. Posizionare l’antenna [1] sul lato su-

periore del fondo in maniera che la
base magnetica [2] aderisca con la
superficie.

 L’antenna può essere posiziona-
ta sul lato superiore del fondo,
nel punto più adatto a ricevere il
segnale GSM.

10. Se necessario montare il Deviatore
Antisabotaggio MAXIASNC [15]
(opzionale) sui perni come mostrato
in Figura 1.

 La levetta del Deviatore deve es-
sere orientata come mostrato in
Figura 1 altrimenti il dispositivo
non funziona correttamente.

11. Eseguire i collegamenti sulla morsettiera
[10] come descritto nel par. “Collega-
menti” e, se necessario, il collegamento
del Deviatore Antisabotaggio (per il col-
legamento del Deviatore Antisabotaggio
vedere il par. “Collegamenti->Colle-
gamenti Ausiliari”).

Fig. 2 - Montaggio scheda
all’interno della centrale.

51

96

a)
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12. Inserire la SIM-CARD [8] nel porta-SIM [6] come indicato dalla freccia, con i contatti verso il basso (vedere la Figura 1).
!!!!! Il PIN della SIM CARD deve essere disabilitato prima del suo inserimento nel Comunicatore.
!!!!! Si consiglia di disabilitare sulla propria SIM-CARD il trasferimento di chiamata.

13. Controllare all’accensione che tutti i LED verdi lampeggino, in questo stato il Comunicatore si trova nella fase di inizializzazione.
14. Controllare l’intensità del segnale:

– assicurarsi che almeno un LED verde si accenda; tutti i LED verdi accesi indicano una copertura ottimale;
– se i LED verdi sono spenti, l’intensità del segnale NON è sufficiente; per un’intensità accettabile, almeno un LED
verde deve essere acceso.

15. Chiudere il Comunicatore: agganciare il lato inferiore del Coperchio [18] al Fondo [17] quindi premere sul lato superiore
del Fondo per chiudere il Coperchio; bloccare il Coperchio tramite le viti [25].

 Collegare l’alimentazione e i circuiti telefonici solo dopo che il Comunicatore è stato fissato ed è stato
collegato al circuito di terra dell’edificio.

!!!!! Prima di inserire o rimuovere la SIM-CARD, assicurarsi che il Comunicatore NON sia alimentato.

COLLEGAMENTI
In questo capitolo sono descritti i morsetti del Comunicatore ed i collegamenti ausiliari. In Figura 3 è riportato un esempio di collegamento.

!!!!! La corrente degli Open Collector non può eccedere i 100 mA. Nel caso sia necessario commutare carichi
maggiori utilizzare dei relè.

Collegamenti ausiliari
I collegamenti ausiliari non sono indispensabili per il funzionamento del Comunicatore, ma consentono di sfruttare al massimo
la versatilità di questo dispositivo. Questi collegamenti vengono descritti nel paragrafo seguente.

Antisabotaggio - Il collegamento del Deviatore Antisabotaggio MAXIASNC (opzionale) permette di rilevare eventuali tentativi di manomis-
sione del coperchio del Comunicatore. Il Deviatore Antisabotaggio è provvisto di un cavetto presaldato e può essere collegato nei seguenti modi:
— Alla linea antisabotaggio o ad una zona appropriata della centrale. Leggere le istruzioni della centrale per maggiori informazioni.
— Tra il morsetto [ T3 ] e [ M ] del GS3125, per fare in modo che alla rimozione del coperchio del Comunicatore sia inviato un

messaggio SMS e/o vocale a uno o più numeri telefonici. In tal caso è necessario tramite il software GS3100 Series Console
programmare il Comunicatore (vedere il paragrafo Programmazione da PC->Programmazione opzionale Antisabotaggio).
Effettuati i collegamenti e la programmazione chiudere il coperchio e alimentare il Comunicatore. Al termine della fase di inizializzazione
del Comunicatore GSM, aprire il coperchio e verificare che il messaggio SMS e/o vocale venga inviato ai numeri programmati.

N. Morsetti
Versione

GS3105-K, GS3105-BA GS3125-K, GS3125-BA

1 +V

Alimentazione fornita dalla centrale o dall’alimentatore esterno (opzionale), da 10 a 27,6 Vcc, assicurarsi che sia
protetta e limitata in corrente: sorgente con potenza limitata (LPS) in accordo alla normativa EN 60950-1:2006.

!  Per collegare l’alimentazione utilizzare cavi di lunghezza massima 2 metri e 0,75 mm² di sezione. Per cavi di
lunghezza inferiore utilizzare sezioni adeguate.

2 M Massa: negativo dell’alimentazione e morsetto comune per le Uscite Open Collector.

3 T1

Uscite Open-Collector: queste uscite sono attivate dagli
eventi guasto sulla linea PSTN (T1) o sulla rete GSM (T2).

Morsetti Programmabili: questi morsetti possono essere
programmati come;
– Uscite Open-Collector (impostazione di fabbrica): queste
uscite possono essere attivate dagli eventi programmati
(Attivazione Automatica), oppure sia tramite comando su
messaggio SMS che tramite riconoscimento del chiamante
(Attivazione da Remoto); leggere il paragrafo  “Attivazione delle
Uscite” per maggiori informazioni. La corrente massima
prelevabile da ciascuna Uscita OC è 100 mA.
– Linee d’Ingresso: questi ingressi quando ricevono dei
Segnali di Allarme possono attivare le funzioni di Avvisatore
SMS e d i Avvisato re Te le fonico (leggere i parag rafi
“Avvisatore SMS” e “Avvisatore Vocale”).

4 T2

5 T3

Uscita Open-Collector Programmabile: questa uscita può
essere attivata dall’evento riconoscimento del chiamante.
La corrente massima prelevabile da ciascuna Uscita OC è
100 mA.

6 -
Terra: questo morsetto deve essere collegato alla Terra dell'impianto elettrico per proteggere il dispositivo dalle
sovratensioni sulla linea telefonica e per soddisfare i requisiti di sicurezza.

7
LE Linea Telefonica Esterna: questi morsetti possono essere collegati alla linea telefonica PSTN.

8
9

LI Linea Telefonica Interna: questi morsetti vanno collegati alla centrale o altro terminale di comunicazione.
10
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Fig. 3 - Esempio di collegamento per la serie GS3105 e GS3125.
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LED DI CONTROLLO
Sulla scheda ci sono 5 LED (vedere la Figura 4); tre LED verdi (L1, L2 e L3), un LED giallo (L4), un LED rosso (L5), che
segnalano la connessione, la trasmissione, le condizioni di malfunzionamento e, solo per la serie GS3125 (vedere la
tabella 2), lo stato del Comunicatore.
 Durante l’inizializzazione e durante la fase di programmazione, i LED lampeggiano.
ROSSO — LED normalmente spento. Segnala una condizione di malfunzionamento, lampeggiando in caso di guasto.Questo

Comunicatore controlla la presenza di alcuni guasti nell’ordine elencato di seguito. Verrà indicato lo stato di malfunzionamento
più importante, con il corrispondente numero di lampeggi del LED ROSSO (L5) (vedere sotto per numero lampeggi e
priorità di segnalazione malfunzionamenti).

GIALLO — Se acceso indica che l’Interfaccia ha commutato sulla Rete GSM a causa di anomalie sulla Linea Telefonica
PSTN o non presenza della stessa. Se lampeggia lentamente, indica chiamata in corso su rete GSM (sia in entrata
che in uscita). Se acceso fisso insieme al LED rosso indica caricamento dati di fabbrica in corso.

VERDE — I tre LED verdi (L1, L2 e L3) segnalano l’intensità di campo GSM e lo stato (tabella 2), come visibile in Figura 4:
Il primo LED (L1, vicino il foro di fissaggio) se è spento indica che la Rete GSM NON è disponibile. Se solo questo LED
è acceso, il livello del segnale GSM è basso ma sufficente per effettuare le chiamate vocali;
Il secondo LED (L2), se acceso indica una buona intensità di campo GSM: questo LED si accende solo quando il primo
LED VERDE è acceso;
Il terzo LED (L3), se acceso indica un’ottima intensità di campo GSM: si accende solo quando il primo ed il secondo
LED sono accesi.

Fig. 4 - LED di controllo.

Simbolo livello segnale GSM
LED di controllo

LED Indicatori di Campo GSM

Numerazione LED
(riferimenti non presenti 

sulla Scheda Elettronica).
 Tale numerazione è stata 

inserita solo per una migliore
 identificazione dei LED 

all’interno del documento.

1 2 3 4 5

Priorità Segnalazione Tipo Malfunzionamento Lampeggi LED Rosso
1 (ALTA) Problema Firmware (firmware non corretto) 1

2 Problema alimentazione 2

3 Problema modulo GSM 3

4 Problema SIM 4

5 Problema di campo GSM 5

6 Problema GPRS 6

7 Ricevitore non disponibile 7

8 (BASSA)
Ricevitore di supervisione assente

(ricevitore 1)
8

Nessun Guasto Spento
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MODALITÀ DI FUNZIONAMENTO

Questo Comunicatore ha la possibilità di scegliere il “Canale Predefinito” di comunicazione. Fornisce la tensione di linea e di
squillo per le chiamate in arrivo e decodifica la Selezione Multifrequenza (DTMF). La Simulazione della Linea Telefonica PSTN
fornisce la centrale antifurto o altro terminale di comunicazione di una linea di riserva in caso di guasto sulla PSTN. La
commutazione tra PSTN e GSM, o viceversa, NON avviene durante le telefonate in uscita. La Priorità di Funzionamento
(da selezionare durante la fase di programmazione) determina come questo Comunicatore gestice le comunicazioni (SMS e
vocali solo per la serie GS3125) e le chiamate dei dispositivi telefonici collegati ai morsetti LI (ad esempio una centrale antifurto).
 NON è in grado di decodificare la Selezione ad Impulsi (Decadica).
 Per prevenire un uso indesiderato della linea simulata via GSM, il dispositivo durante le chiamate vocali genera un

doppio beep di segnalazione. Il primo doppio beep è generato dopo 5 minuti, i successivi ad intervalli di 30 secondi.

Ripristino Programmazione di Fabbrica
Per ripristinare la programmazione di fabbrica del Comunicatore, procedere come descritto di seguito.
1. Togliere l’alimentazione al Comunicatore.
2. Tenendo cortocircuitati, ad esempio con delle pinzette, i piedini 1 e 4 del connettore [9] (fig. 5 a pag. 41), ripristinare l’alimentazione.
3. I 5 LED (L1, L2, L3, L4 e L5)  si accendono per qualche istante (meno di 1 secondo).
4. Appena il corto viene rilevato i 3 LED verdi (L1, L2, L3) si spengono mentre i LED giallo e rosso (L4, L5) rimangono accesi

(qualche secondo) per segnalare che è in corso il ripristino delle programmazioni di fabbrica.
5. All’accensione dei LED giallo e rosso (L4, L5) rimuovere il cortocircuito dai piedini 1 e 4 del connettore [9] (fig. 5 a pag. 41).
6. Terminata la procedura i 3 LED verdi lampeggiano per segnalare che il Comunicatore è in fase di inizializzazione.
 I messaggi vocali registrati NON sono cancellati quando si esegue il ripristino della programmazione di fabbrica.

Canale Predefinito PSTN
Se la tensione sui morsetti della Linea Telefonica PSTN (LE) scende sotto i 3 Vcc per un tempo compreso tra 10 e 3600 secondi
(valore programmabile) i dispositivi telefonici collegati ai morsetti LI vengono commutati sulla Rete GSM. Al ripristino della
Linea Telefonica PSTN, esso commuta, nuovamente dopo un tempo programmabile, sulla Linea Telefonica PSTN.

Canale Predefinito GSM
Fornisce ai dispositivi collegati ai morsetti LI la linea simulata se è presente la copertura GSM. In caso di mancanza di campo
GSM, commuta sulla Linea Telefonica PSTN.

Sequenza Trasmissione Contact ID su GPRS
Il Comunicatore, nel caso in cui sono stati inseriti dei numeri di telefono sulla pagina Gprs->Numeri di Telefono da
decodificare tramite il software GS3100 Series Console, indirizza le chiamate a tali numerazioni su linea GPRS.
 Quando si verifica un evento, la centrale antifurto prende la linea telefonica.
 Viene simulato il tono di chiamata.
 La centrale antifurto compone il numero della Centrale di Vigilanza. Assicurarsi che la centrale antifurto inserisca una

pausa di almeno 1 secondo oppure che verifichi la presenza del Tono di Chiamata, prima di comporre il numero.
 Questo Dispositivo invia il doppio tono di handshake richiesto per il Contact ID.
 Dopo aver ricevuto l’handshake, la centrale antifurto trasmette gli eventi di allarme in formato DTMF.
 Il Comunicatore decodifica e trasforma le cifre DTMF in pacchetti e l’invia al ricevitore della Centrale di Vigilanza tramite la rete GPRS.
 Il ricevitore riconosce l’evento e invia il comando a questo Comunicatore che genera il corrispondente segnale di kiss-off

(la frequenza del segnale di kiss-off è di 1400Hz) alla centrale.
 Dopo che questo Comunicatore ha generato il segnale di kiss-off, se non ci sono altri eventi che devono essere inviati,

la centrale antifurto riaggancia, altrimenti essa può inviare l’evento successivo.

Tabella 2 - Segnalazioni sullo stato
del Comunicatore per la serie
GS3125 tramite il lampeggio dei
LED Verdi (L1,L2,L3).

Lampeggi LED Verdi Significato della segnalazione

L1 Trasmissione messaggio vocale in corso

L3
Sessione Remota; lampeggia fino all'uscita dalla sessione

remota GPRS.
L1+L2 Modalità di servizio; lampeggiano fino all'uscità dalla modalità

L2+L3 Messaggio SMS in arrivo; lampeggiano per 5 secondi.

L1+L2+L3
Il Comunicatore è in fase di inizializzazione; lampeggiano fino

alla ricezione di un segnale GSM
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Avvisatore SMS (solo per la serie GS3125)
Nella modalità di funzionamento come Avvisatore SMS sono chiamati uno o più numeri telefonici (i primi 8 numeri telefonici della
rubrica) ai quali inviare i Messaggi SMS programmati in precedenza associati ai seguenti eventi, (vedere la tabella seguente):

 Segnali di Allarme che dovessero presentarsi su una o più delle 3 Linee d’Ingresso Programmabili. Si tenga presente che
per ognuna delle 3 Linee di Ingresso del dispositivo è possibile programmare 2 Messaggi SMS: quello di Attivazione e
quello di Ripristino.

 Test Linea PSTN. È possibile programmare 2 SMS: quello di mancanza Linea PSTN e quello di Ripristino.
 Test tensione di Alimentazione. È possibile programmare 2 SMS: uno che segnala problemi alla tensione di Alimentazio-

ne e uno di Ripristino.
 Invio SMS Periodico con un periodo programmabile da 1 ora a 1 anno.

 L’invio di un Messaggio SMS avviene quando si verifica uno degli eventi appena descritti per il quale è stato
programmato un messaggio SMS ed almeno un numero telefonico.

Avvisatore Vocale (solo per la serie GS3125)
Nella modalità di funzionamento come Avvisatore Vocale sono chiamati uno o più numeri telefonici  (i primi 8 numeri telefonici
della rubrica) ai quali inviare un messaggio vocale preregistrato. Si possono registrare fino a 8 messaggi della durata massima
di 16 secondi ciascuno. Ogni messaggio è registrato  su memorie a stato solido, eliminando in tal modo tutti i problemi connessi
all’uso del nastro magnetico, quali: deterioramento della qualità del messaggio col passare del tempo; blocco della meccanica
dopo lunghi periodi di inattività; ecc... I messaggi sono associati ai seguenti eventi (vedere la tabella seguente):

N Descrizione Evento
Numeri di telefono programmati

(primi 8 numeri della rubrica) Messaggio SMS
1 2 3 4 5 6 7 8

1  Attivazione Ingresso 1 *Stringa SMS
2 Ripristino Ingresso 1 *Stringa SMS
3 Attivazione Ingresso 2 *Stringa SMS
4 Ripristino Ingresso 2 *Stringa SMS

5 Attivazione Ingresso 3 *Stringa SMS
6 Ripristino Ingresso 3 *Stringa SMS
7 Evento Guasto PSTN
8 Ripristino Guasto PSTN *Stringa SMS
9 Evento Guasto Alimentazione

10 Ripristino Guasto Alimentazione *Stringa SMS
11 SMS Periodico *Stringa SMS

  Evento Disabilitato sul numero di telefono
  Evento Abilitato sul numero di telefono

  *   La stringa dell'SMS può avere una lunghezza massima di 100 caratteri

N Descrizione Evento
Numeri di telefono programmati

(primi 8 numeri della rubrica) Mess. #1 Mess. #2 Mess. #3
1 2 3 4 5 6 7 8

1  Attivazione Ingresso 1

2 Ripristino Ingresso 1
Messaggio

Vocale 1
Messaggio
Vocale 2

3 Attivazione Ingresso 2

4 Ripristino Ingresso 2
Messaggio
Vocale 2

5 Attivazione Ingresso 3
6 Ripristino Ingresso 3
7 Evento Guasto PSTN
8 Ripristino Guasto PSTN
9 Evento Guasto Alimentazione

10 Ripristino Guasto Alimentazione
11 Chiamata Periodica

  Evento Disabilitato sul numero di telefono
  Evento Abilitato sul numero di telefono
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 Segnali di Allarme che dovessero presentarsi su una o più delle 3 Linee d’Ingresso Programmabili. Si tenga presente che per
ognuna delle 3 Linee di Ingresso del dispositivo è possibile registrare 2 Messaggi Vocali: quello di Attivazione e quello di Ripristino.

 Test Linea PSTN. È possibile registrare 2 Messaggi Vocali: quello di mancanza Linea PSTN e quello di Ripristino.
 Test tensione di Alimentazione. È possibile programmare 2 Messaggi Vocali: uno che segnala problemi alla tensione di

Alimentazione e uno di Ripristino.
 Invio Messaggio Vocale Periodico con un periodo programmabile da 1 ora a 1 anno.
La chiamata vocale avviene quando si verifica un evento su un canale per il quale sia stato programmato un messaggio
vocale ed almeno un numero di telefono.
In tal caso il Comunicatore esegue le fasi descritte di seguito:
1. Il Comunicatore seleziona il numero telefonico ed inoltra la chiamata sulla linea telefonica GSM.
2. Il Comunicatore verifica che il numero non sia occupato o che non ci siano problemi sulla rete GSM affinchè si possa

procedere con la fase successiva, altrimenti si termina la chiamata e si ritenta di nuovo dalla Fase 1 per un massimo di
8 volte (secondo il valore programmato) oltre le quali il ciclo di chiamate si considera terminato.Se il Canale di Allarme è
stato programmato per chiamare più numeri telefonici, questi verranno chiamati in sequenza. Così facendo, ad esempio,
si evita la possibilità di richiamare più volte e nell’arco di pochi secondi, un numero occupato.

3. Il Comunicatore attende fino a 60 secondi la risposta del numero chiamato. In caso di esito positivo, si passa alla Fase
4, altrimenti si termina la chiamata e si ritenta di nuovo dalla Fase 1 per un massimo di 8 volte (secondo il valore
programmato) oltre le quali il ciclo di chiamate si considera terminato.

4. Il Comunicatore riproduce il messaggio relativo al canale andato in allarme, la chiamata si considera terminata solo dopo la
ricezione del messaggio oppure alla pressione del tasto  (se programmata la “Conferma chiamata”, vedere il paragrafo
Avvisatore Vocale->Conferma chiamata) sul telefono che ha ricevuto il messaggio. In ogni caso la chiamata si considera
andata a buon fine dopo che il messaggio è stato ripetuto per un massimo di 8 volte (secondo il valore programmato).
Se all’atto della selezione si sono verificati più eventi che determinano l’invio di diversi messaggi allo stesso numero telefonico,
tali messaggi vengono riprodotti (ciascuno sempre per un massimo di 8 volte, secondo il valore programmato) in sequenza
durante la stessa telefonata evitando di chiamare più volte lo stesso numero. Se al termine del ciclo di chiamate, la Linea che ha
provocato l’attivazione del Comunicatore è ancora in allarme, la procedura appena descritta non verrà eseguita di nuovo. È
necessario, infatti,che la linea che ha provocato un ciclo di chiamata torni a riposo prima di attivarne uno nuovo.

Gestione delle Priorità (solo per la serie GS3125)
Il Comunicatore è in grado di trasmettere gli eventi di allarme ed i messaggi (SMS o vocali), alcune priorità sono
programmabili tramite il software GS3100 Series Console (vedere la parte relativa alla programmazione tramite il software
GS3100 Series Console), di seguito è rappresentata la tabella di gestione delle priorità con le impostazioni di fabbrica.

Tabella di gestione delle priorità

Priorità
Evento Descrizione Evento

Impostazioni di
fabbrica

Programmabile
da software

1 (ALTA)  Richiesta Linea LI  (sgancio)  Si

2 Avvisatore Vocale (messaggi vocali)  Si

*3 (BASSA) Supervisione GPRS  No

* L'evento di Supervisione GPRS è il più basso e non è programmabile da software

Priorità alla Linea Telefonica Simulata
Quando il dispositivo collegato ai morsetti LI chiede la linea, qualsiasi eventuale chiamata effettuata in quel momento in
modalità Avvisatore Vocale viene terminata. Sono così effettuate le chiamate richieste dal dispositivo collegato ai morsetti LI
(ad esempio, una centrale antifurto). Quando il dispositivo collegato ai morsetti LI rilascia la linea, l’Avvisatore Vocale,
tornerà ad effettuare le chiamate lasciate in sospeso e ad inviare i messaggi vocali.

Priorità Avvisatore SMS
Nel caso in cui un apparecchio collegato ai morsetti LI stia effettuando una chiamata su GSM attraverso questo Comunicatore e sia necessario
effettuare un’azione da Avvisatore SMS, la chiamata da interfaccia non sarà terminata e il messaggio SMS sarà comunque inviato.

Priorità degli Eventi dell’Avvisatore
IMessaggi SMS hanno una priorità più bassa rispetto ai Messaggi Vocali ma non posso essere interrotti mentre sono
trasmessi: in questo caso, il Messaggio Vocale sarà messo in coda e sarà inviato dopo il Messaggio SMS.
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Controllo credito residuo (solo per la serie GS3125)
Se programmato tramite il software GS3100 Series Console (vedere la pagina Opzioni->Controllo Credito Residuo), è
possibile controllare il credito residuo sulla SIM CARD prepagata. Abilitando il controllo del credito residuo, viene periodica-
mente inviato al primo numero in rubrica un SMS contenente le informazioni fornite dall’operatore sul credito residuo. Per
tutti gli operatori che supportano la richiesta del credito residuo tramite comando di rete, è possibile inserire la stringa di
interrogazione tramite il software GS3100 Series Console.
 NOTA BENE - A discrezione del singolo operatore di Rete GSM, il servizio di gestione credito delle SIM

CARD prepagate può essere sospeso.

(PTM) Controllo delle comunicazioni con la centrale
Il controllo costante delle comunicazioni con la Centrale (funzione PTM) consente al Comunicatore di inviare le chiamate
tramite rete GSM nel caso che la comunicazione tra la centrale di allarme e la centrale di vigilanza non avviene con
successo sulla linea telefonica PSTN. Se programmata, (tramite il software GS3100 Series Console pagina PTM), questa
caratteristica è operativa solo quando la linea PSTN è connessa ai morsetti LE presenti.
La funzione PTM è correlata alle seguenti modalità di trasmissione dell’allarme del Comunicatore:
1. Allarme su GPRS (comunicazioni IP ricevitore).
2. Allarme su GSM (modalità voce).
 Quando la funzione PTM è attivata si verifica l’evento Guasto PSTN.

ATTIVAZIONE DELLE USCITE
La serie GS3105 possiede 3 Uscite di tipo Open Collector (i morsetti T1, T2 e T3). La serie GS3125 possiede 3 morsetti ( T1, T2 e T3)
che possono essere programmati come Ingressi e/o Uscite:  questi morsetti sono programmati di fabbrica come Uscite. Le Uscite Open
Collector possono essere attivate in modo automatico (al verificarsi di certi eventi preprogrammati) oppure da remoto, mediante l’invio
di un SMS (invio SMS solo per la serie GS3125) o il Riconoscimento del Chiamante da un numero programmato in precedenza.

Attivazione e disattivazione delle Uscite in automatico
Le Uscite Open Collector T1, T2 e T3 di questo Comunicatore possono essere attivate in modo automatico dai seguenti eventi:
 Mancanza Linea Telefonica PSTN (T1, per la serie GS3105).
 Mancanza Rete GSM (T2, per la serie GS3105).
 Mancanza del messaggio di supervisione (solo per la serie GS3125).
 Fallimento della comunicazione di un evento interno (FTC), (solo per la serie GS3125).
 Un’Uscita OC attivata in automatico, torna a riposo quando sono rimosse tutte le cause che ne hanno

provocato l’attivazione; tranne che per fallimento della comunicazione di un evento interno (FTC), in questo
caso torna a riposo dopo un tempo programmato (Tempo di ON).

Attivazione e disattivazione delle Uscite da remoto
 ATTENZIONE - Deve essere presente la connessione GSM affinchè che le uscite possano essere attivate/

disattivate da remoto.
 Si consiglia di programmare il dispositivo con la Black List attivata (Opzioni->Opzioni di Composizione) e White

List disattivata (Rubrica Telefonica->White List) per quei numeri che si vogliono utilizzare per tale funzionalità.
 Il numero usato per l’attivazione delle uscite mediante il Riconoscimento del Chiamante deve essere visibile.

GS3105
Le Uscite Open Collector T1 e T2 sono Bistabili mentre l’Uscita T3 è Monostabile (l’Uscita rimane attiva per il tempo di
ON, trascorso il quale torna a riposo).

GS3125
Le Uscite Open Collector possono essere impostate come Bistabili (l’attivazione e la disattivazione avviene attraverso 2 comandi distinti)
oppure come Monostabili (l’Uscita rimane attiva per il Tempo di ON, trascorso il quale torna a riposo). Inoltre, ogni uscita può essere
programmata per fornire un segnale di conferma (un SMS precedentemente programmato se l’attivazione/disattivazione dell’uscita viene
fatta tramite SMS, oppure uno squillo di conferma se l’attivazione/disattivazione avviene tramite il riconoscimento del chiamante).
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 Per maggiori informazioni sui termini “Stringa di Controllo” e “Codice Utente” usati nei paragrafi seguenti,
fare riferimento ai paragrafi “Ingressi/Uscite” e “Opzioni->Codici” del capitolo “PROGRAMMAZIONE DA PC”.

Uscite Bistabili (solo GS3125)
Le Uscite Open Collector impostate come Bistabili possono essere attivate in 2 modi:
1. Inviando un SMS formato dal Codice Utente racchiuso fra i caratteri #, dalla Stringa di Controllo (all’inizio della

Stringa di Controllo non devono esserci spazi vuoti) e dai caratteri “=ON#” secondo la seguente sintassi:

#Codice Utente#Stringa=ON#   (esempio: #9876#LUCECASA=ON#)

2. Attraverso il riconoscimento del chiamante: in tal caso l’Uscita viene attivata a “costo zero” in quanto il dispositivo,
dopo aver riconosciuto il chiamante, rifiuta la chiamata e attiva l’uscita.

 La disattivazione di un’Uscita OC di tipo Bistabile può essere fatta SOLO attraverso l’invio di un messaggio
SMS formato dal Codice Utente racchiuso fra i caratteri #, dalla Stringa di Controllo e dai caratteri “=OFF#”
secondo la seguente sintassi:

#Codice Utente#Stringa=OFF#   (esempio: #9876#LUCECASA=OFF#)

 Il Codice Utente impostato di fabbrica è ‘0001’; per sostituirlo vedere il paragrafo “Programmazione
tramite SMS->Modifica del Codice Utente”.

Uscite Monostabili
Le Uscite OC impostate come Monostabili possono essere attivate in 2 modi: tramite il Riconoscimento del Chiamante
e tramite SMS (solo GS3125).

SMS (solo GS3125)
Inviare un SMS formato dal Codice Utente racchiuso fra i caratteri #, dalla Stringa di Controllo (all’inizio della Stringa di
Controllo non devono esserci spazi vuoti) e dai caratteri “=ON#”,“=ON#TonU#” oppure “=OFF#” secondo la seguente sintassi:

#Codice Utente#Stringa=ON#
#Codice Utente#Stringa=ON#TonU#

#Codice Utente#Stringa=OFF#

Il parametro “=ON#TonU#” permette di impostare il Tempo di ON da 1 secondo a 86400 secondi, con passi da 1 secondo.
Il Tempo di ON può essere impostato anche tramite il software di programmazione del Comunicatore. La sintassi “Ton”
rappresenta il valore e “U” l’unità espressa in H (ore) M (minuti) e S (secondi), vedere gli esempi seguenti:

SMS Modo di funzionamento delle uscite

#9876#LUCECASA=ON# Attivazione Bistabile

#9876#LUCECASA=ON#3600S# Attiva per 3600 secondi

#9876#LUCECASA=ON#50M# Attiva per 50 minuti

#9876#LUCECASA=ON#3600#
Attiva come da programmazione

software, il Tempo di ON impostato
non è valido

 Per attivare l’uscita tramite SMS rispettando la programmazione togliere il parametro “TonU” lasciando i caratteri “##”.

(esempio: #9876#LUCECASA=ON##)

Riconoscimento del chiamante
L’uscita viene attivata a “costo zero” in quanto il Comunicatore, dopo aver riconosciuto il chiamante, attiva l’uscita senza
rispondere alla chiamata.

 Le Uscite OC di tipo Monostabile tornano a riposo dopo il Tempo di ON programmato.

 Solo l’Uscita T3 del GS3105 può essere attivata mediante il Riconoscimento del Chiamante.

Il Tempo di ON può essere impostato da 1 secondo a 86400 secondi, con passi da 1 secondo.

 Il Codice Utente impostato di fabbrica è ‘0001’ per sostituirlo vedere il paragrafo “Programmazione tramite
SMS->Modifica del Codice Utente”.
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PROGRAMMAZIONE TRAMITE SMS
 (solo per la serie GS3125)

Oltre a quelle descritte nel paragrafo Attivazione e Disattivazione delle Uscite da remoto , si possono effettuare altre
operazioni da remoto tramite l’invio di opportuni messaggi SMS.

Modifica del Codice Utente
Il Codice Utente impostato di fabbrica è ‘0001’ per sostituirlo inviare un messaggio SMS formato dai caratteri “#CUC” seguiti
dal vecchio Codice Utente e dal nuovo Codice Utente racchiusi fra i caratteri * secondo la seguente sintassi:

#CUC*Codice Utente*Nuovo Codice Utente*
 Per la composizione del Codice Utente possono essere utilizzati solo i numeri da 0 a 9 (al massimo 4 cifre).
Un SMS confermerà che il Codice Utente è stato cambiato.

Abilitare o disabilitare la programmazione remota
La programmazione remota permette di utilizzare tramite rete le funzionalità offerte dall’applicazione software GS3100 Series Console. Per
gestire da remoto i parametri del Comunicatore occorre abilitare la programmazione remota, questo può essere fatto tramite il software
GS3100 Series Console (vedere il paragrafo Programmazione da PC->GPRS->Programmazione remota), oppure inviando un
messaggio SMS formato dai caratteri “#UWS” seguiti dal Codice Utente e da “ON” racchiusi fra i caratteri * secondo la seguente sintassi:

#UWS*Codice Utente*ON*
Per disabilitare invece la programmazione remota inviare il seguente messaggio SMS:

#UWS*Codice Utente*OFF*
Un SMS confermerà se il comando ha avuto successo.

Modifica del Codice Installatore
Il Codice Installatore (al massimo 4 caratteri numerici) è utilizzato in caso di necessità per l’accesso all’interfaccia di
programmazione remota (vedere il paragrafo Programmazione da PC->Codici->Codice Installatore). Il Codice Installatore
impostato di fabbrica è ‘0002’ per sostituirlo inviare un messaggio SMS formato dai caratteri “#CIC” seguiti dal vecchio
Codice Installatore e dal nuovo Codice Installatore racchiusi fra i caratteri * secondo la seguente sintassi:

#CIC*Codice Installatore*Nuovo Codice Installatore*
 Per la composizione del Codice Installatore possono essere utilizzati solo i numeri da 0 a 9 (al massimo 4 cifre).
Un SMS confermerà che il Codice Installatore è stato cambiato.

Controllo del credito residuo
Per conoscere il credito residuo tramite un messaggio SMS si può procedere attraverso il software GS3100 Series Console
(vedere il paragrafo Programmazione da PC->Opzioni->Controllo Credito Residuo), oppure da remoto inviando un
messaggio SMS formato dai caratteri “#CCC” seguiti dal carattere * secondo la seguente sintassi:

#CCC*
 L’SMS con credito residuo sarà inviato al Numero Telefonico #1 della Rubrica.

A discrezione del singolo operatore di Rete GSM, il servizio di gestione credito delle SIM CARD prepagate
può essere sospeso.

PROGRAMMAZIONE DA PC
 Per il corretto funzionamento di questo Comunicatore, usare SIM-CARD da 32 K o superiori.
Per effettuare la Programmazione da PC è necessario il cavo PC-Link (non fornito), collegato tra il connettore [9] del Comunicatore e una porta
COM del PC (vedere figura 5) e l’applicazione GS3100 Series Console. Per il collegamento è possibile usare il cavo PC-Link rappresentato
in figura 5a oppure il cavo PC-Link rappresentato in figura 5b. Fare attenzione al verso di inserimento del connettore del cavo PC-Link usato.
Una volta effettuato il collegamento, selezionare la porta COM utilizzata tramite la voce di Menù Opzioni->Porte seriali. Nel caso ci sia un
problema di comunicazione controllare il collegamento e le impostazioni della porta seriale oppure utilizzare un convertitore USB-seriale diverso.
 Per installare ed eseguire l’applicazione GS3100 Series Console, è necessario disporre dei diritti di Ammi-

nistratore del PC; si consiglia, inoltre, di verificare le impostazioni del firewall se si verificano dei problemi
durante l’installazione dell’applicazione.
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Leggere la Programmazione
Per leggere la programmazione del Comunicatore e visualizzarla sul PC, selezionare l’icona Caricamento dal dispositivo .

Inviare la Programmazione
Una volta effettuata la Programmazione per un nuovo cliente (oppure modificate le impostazioni di un cliente caricato in
precedenza), inviare la programmazione al Comunicatore, utilizzando l’icona Invio al dispositivo .

Operazioni preliminari
All’esecuzione dell’applicazione viene presentata la finestra principale; sulla parte alta a sinistra della stessa  selezionando
con un click del mouse la voce di menù Senza Titolo #1, appaiono due sezioni.
 Nella sezione dei parametri generali sono presenti le seguenti applicazioni:

Impostazioni Centrale: in questa sezione è possibile impostare la serie del Comunicatore (GS3105 o GS3125),
oltre che richiamare ed aggiornare la configurazione relativa ad un cliente con la seguente procedura:
1. Cliccare con il tasto sinistro sull’applicazione.
2. Inserire o aggiornare i dati relativi al cliente e all’impianto. Confermare con il tasto .
Caricamento dal dispositivo: selezionando questa icona i dati programmati sulla scheda sono caricati sul PC.
Invio al dispositivo: selezionando questa icona i dati programmati sono inviati alla scheda. L’invio al dispositivo
di tutta la programmazione o delle pagine “GPRS”, “Ingressi/Uscite” (solo per GS3125) e “Opzioni” (solo per
GS3105) riavvierà il Comunicatore.
Dati di Fabbrica: selezionando questa icona si esegue il ripristino della programmazione di fabbrica. Da notare che
il ripristino della programmazione di fabbrica non cancella i messaggi vocali registrati.
Reset dispositivo: la selezione di questa icona provoca il reset del Comunicatore.

  Nella sezione comune alla serie GS3105 e GS3125 sono presenti le seguenti pagine.
Rubrica Telefonica: pagina relativa alla rubrica telefonica.

Opzioni: pagina delle opzioni.

GPRS: pagina parametri GPRS.

Stato: pagina per il controllo del Comunicatore.

PTM: pagina per impostare le caratteristiche della funzione PTM.

Fig. 5 - Schema di collegamento del cavo PC-Link.
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Le successive pagine sono disponibili solo per il Comunicatore serie GS3125.

Ingressi/Uscite: in questa pagina si programmano i parametri per le uscite/ingressi del Comunicatore.

Avvisatore Vocale: pagina dove impostare tutti i parametri relativi all’avvisatore vocale.

Avvisatore SMS: in questa pagina vanno programmate tutte le opzioni dell’avvisatore SMS.

Messaggi Vocali: pagina per la gestione dei messaggi vocali.

Se si desidera iniziare la programmazione per un nuovo cliente, selezionare la voce di Menù File->Nuovo.
Per visualizzare la Lista dei Clienti caricati in archivio, selezionare la voce di menù File->Apri. In questa sezione è possibile
eliminare o richiamare la configurazione relativa ad un cliente con la seguente procedura:

1. Cliccare con il tasto destro del mouse sul nome desiderato.

2. Selezionare Carica  per caricare i dati dall’archivio su Hard-Disk oppure Cancella il cliente selezionato 
per cancellare definitivamente il cliente e tutti i suoi dati dall’archivio.
Per caricare un Cliente è anche possibile effettuare un doppio-click sul nome dello stesso.
È anche possibile ordinare alfabeticamente o per codice la lista con un click del mouse sull’intestazione della relativa colonna.

Tutti i parametri da programmare sono raccolti nelle pagine seguenti. La pagina (Stato) è per il controllo e la gestione del
Comunicatore. In questo capitolo sono descritte in dettaglio le pagine presenti nell’applicazione.

Rubrica Telefonica
In questa pagina possono essere memorizzati fino a 100 numeri telefonici.
 Il credito residuo della prepagata è inviato, tramite SMS, al numero telefonico #1.
 Descrizione: inserire una stringa alfanumerica di 16 caratteri al massimo.
 Numero di Telefono: inserire un numero telefonico preceduto dal prefisso internazionale in formato “+xxx” (esempio:

+39 per l’Italia). Sono ammesse 16 cifre al massimo (il carattere “+” conta come una cifra).
 Attiva Uscita: selezionare i numeri telefonici che possono attivare le Uscite T1 (OC1), T2 (OC2) e T3 (OC3) quando il

Comunicatore riceve una chiamata da questi. Tale funzione non dipende dalle opzioni di White List o Black List (pagina
Opzioni->Opzioni chiamate). Per l’attivazione dell’uscita, è necessario che sia abilitato il servizio di idendificazione
del chiamante (Calling Line IDentifier).

 Per la serie GS3105 è possibile attivare solo l’Uscita T3 (OC3).
Per l’attivazione dell’uscita, sulla serie GS3125, programmare i terminali T1 (OC1), T2 (OC2) e T3 (OC3) come
“Uscita” e abilitare “Uscita Riservata” (vedere le pagine Ingressi/Uscite->Tipo e Ingressi/Uscite->Uscita Riservata).

 Conferma Attivazione Uscita: questa opzione è disponibile solo per la serie GS3125, abilitare questa casella per
ricevere uno squillo di conferma dell’avvenuta attivazione dell’uscita.

 ATTENZIONE:
— lo squillo viene ricevuto dopo 1 minuto dall’attivazione dell’uscita;
— se il Comunicatore è impegnato in un’operazione (ad esempio: il canale GSM è impegnato in una comuni-
cazione vocale), lo squillo di conferma non viene effettuato;
— l’opzione “Conferma Attivazione Uscita” abbatte la chiamata entrante dopo circa 5 s anche se l’opzione
“Black List” non è abilitata.

 White List : abilitare o disabilitare   la casella White List consente al Comunicatore di accettare o rifiutare le
chiamate in ingresso. Il Comunicatore accetta le chiamate in ingresso inoltrandole ai dispositivi telefonici collegati ai
morsetti LI (ad esempio una centrale antifurto); questo è possibile solo se LI è in funzione come linea simulata via GSM.
Il modo di funzionamento dell’opzione White List è legato alla selezione o meno della casella Black List, presente
all’interno della pagina Opzioni->Opzioni di composizione, come visibile nella tabella seguente:

Opzioni
Questa pagina è per l’impostazione delle opzioni relative alla scheda.

White List Black List Modo di funzionamento

  Accetta chiamate in ingresso da qualsiasi numero.
  Rifiuta qualsiasi chiamata in ingresso.

 
Accetta chiamate in ingresso solo dai numeri con l'opzione White
List abilitata, rifiuta le chiamate provenienti da tutti gli altri numeri.
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Opzioni di Composizione
Questa parte è per l’inserimento di alcune caratteristiche relative ai numeri telefonici.
  Prefisso: il numero inserito in questa casella viene anteposto a qualsiasi numero telefonico chiamato dal Comunicatore in

modalità Interfaccia GSM. Digitare il prefisso desiderato (da 1 a 8 cifre) oppure lasciare la casella vuota, se non utilizzata.
 Cifre da rimuovere: se questo Comunicatore è collegato a valle di un centralino telefonico, i numeri di telefono (programmati sulla

centrale) devono essere preceduti dal numero del centralino (normalmente una cifra). Poichè il numero del centralino non è necessario
quando le chiamate sono inviate sulla rete GSM, esso deve essere rimosso dalle cifre che formano il numero di telefono. Digitare il
numero di cifre che formano il numero del centralino (es.: se il numero del centralino è 01, digitare 2 nel campo “Cifre da rimuovere”).

 Il numero telefonico deve avere almeno due cifre in più rispetto al numero inserito nel campo “Cifre da
rimuovere”, altrimenti viene generato il tono di occupato, esempio:
— il numero telefonico digitato è 0123, il numero di cifre da rimuovere è 2 = corretto, il numero composto residuo è 23;
— il numero telefonico digitato è 123, il numero di cifre da rimuovere è 2 = tono di occupato, il numero
composto residuo è 3.

 Abilita Black List: selezionare questa casella per non ricevere chiamate dai numeri telefonici autorizzando solo quelli
precedentemente selezionati tramite la casella White List (pagina Rubrica Telefonica->White List).

 La sola funzione “Black List” abbatte la chiamata immediatamente.
 La funzione “Black List” COMBINATA con la funzione “Attiva Uscita” su riconoscimento del chiamante produce

l’abbattimento della chiamata ritardata di qualche secondo.
Lo squillo di conferma associato alla funzione “Attiva Uscita” su riconoscimento del chiamante produce
l’abbattimento della chiamata ritardata di qualche secondo.
Se l’uscita non può essere attivata, GS3125/GS3105 abbatte immediatamente la chiamata.

Priorità Evento (solo per la serie GS3125)
In questa pagina possono essere programmate alcune priorità del Comunicatore per la trasmissione degli eventi di allarme
(vedere il paragrafo Gestione delle Priorità).
 Dispositivi su LI: in questa casella è possibile definire la priorità dei dispositivi telefonici collegati ai morsetti LI (ad

esempio una centrale antifurto). Di fabbrica è abilitata , per disabilitarla togliere il segno di spunta .
 Avvisatore Vocale: in questa casella è possibile definire la priorità dell’Avvisatore telefonico (messaggi vocali). Di

fabbrica è disabilitata , per abilitarla inserire il segno di spunta .

Codici (solo per la serie GS3125)
 Codice Utente: in questa casella deve essere digitato il codice utente (al massimo 4 caratteri numerici) per l’attivazione

da Remoto delle Uscite. Per ulteriori informazioni consultare il paragrafo “Attivazione delle Uscite->Attivazione e
Disattivazione delle Uscite da remoto”. Di fabbrica è impostato il codice ‘0001’.

 Codice Installatore: in questo campo è possibile digitare il codice installatore (al massimo 4 caratteri numerici). Questo codice
permette, in caso di necessità, di accedere all’interfaccia “Programmazione remota”. Di fabbrica è impostato il codice ‘0002’.

Generico
In questa sezione è possibile impostare i livelli audio dell’altoparlante e del microfono del Comunicatore GSM.
 Volume Altoparlante: spostando il cursore è possibile regolare il volume dell’altoparlante.
 Volume Microfono: spostando il cursore è possibile regolare il volume del microfono.
 ATTENZIONE: un volume elevato del microfono potrebbe corrompere i toni DTMF, provenienti dai dispositivi

collegati ai morsetti LI, rendendoli irriconoscibili.
 Parametri Telefonici: selezionare il nome del paese di installazione del Comunicatore: il paese selezionato stabilisce

una serie di parametri per il corretto funzionamento della linea telefonica simulata.
 Tempo Guasto LE: inserire il tempo in secondi (da 10 a 3600 secondi) senza linea telefonica sui morsetti LE, prima

che si verifichi l’evento Guasto PSTN.
 In presenza di dispositivi telefonici collegati ai morsetti LI il tempo può aumentare fino ad un massimo di circa 60 secondi.
 Tempo Ripristino LE: inserire il tempo in secondi (da 30 a 3600 secondi) per il quale la linea telefonica deve essere

presente sui morsetti LE, prima che sia ripristinato l’evento Guasto PSTN.

Sistema (solo per la serie GS3125)
Questa parte è relativa al Sistema.
 Numero di telefono SIM: digitare il numero telefonico della SIM CARD inserita nel Comunicatore (massimo 16 cifre).
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 Regolazione Orologio Automatica: selezionando questa casella il Comunicatore aggiornerà la data e l’ora di sistema
inviandosi automaticamente un SMS.

 Numero centro servizi SMS: questa è un’opzione non modificabile, che mostra il numero del centro servizi SMS
presente sulla SIM CARD.

Controllo Credito Residuo (solo per la serie GS3125)
  A discrezione del singolo operatore di Rete GSM, il servizio di gestione credito delle SIM CARD prepagate

può essere sospeso.
Tramite questa sezione è possibile inviare periodicamente al primo numero in rubrica un SMS contenente le informazioni fornite dall’operatore
sul credito residuo. Programmare le seguenti opzioni per una corretta richiesta del credito residuo in base al tipo di operatore in uso:
 Tipo Richiesta: scelta del tipo di richiesta (SMS, Chiamata, Comando di rete).
 Numero Richiesta: numero telefonico da chiamare o al quale mandare un SMS per richiedere l’informazione del credito residuo.
 Messaggio Credito Residuo: stringa utilizzata sia per l’invio di SMS che per richieste tramite comando di rete.

 Intervallo: digitare in queste caselle l’intervallo (HH-GG) entro il quale inviare un SMS Periodico con le informazioni sul
credito residuo (se gestito dall’operatore telefonico). L’intervallo è composto dai seguenti valori:
— (HH) ora prossimo invio - Selezionare il valore per l’invio del successivo SMS Periodico. L’intervallo dei valori
ammissibili va da 0 a 23.
— (GG) giorno prossimo invio - Selezionare il valore per l’invio del successivo SMS Periodico. L’intervallo dei valori
ammissibili va da 0 a 365.

Uscite (solo per la serie GS3105)
In questa sezione è possibile impostare le modalità di funzionamento delle uscite.
 Uscita 1,Uscita 2,Uscita 3: selezionare la casella per il funzionamento dell’uscita come normalmente chiusa o

normalmente aperta.
 Tempo di Attivazione Uscita 3: su questo campo è possibile inserire il Tempo di attivazione (Tempo di ON) in secondi

(da 0 a 86400 secondi).

Canale Primario
L’utente può programmare la linea primaria di comunicazione.
 Canale Primario: selezionare in questo campo la linea primaria GSM o PSTN.

GPRS
Questa pagina è per l’impostazione dei parametri relativi al GPRS.
 Considerati i possibili ritardi di trasmissione su GPRS, dipendenti dalle attività del gestore di rete, si consiglia

di programmare un numero di tentativi di chiamata, sulla centrale antifurto, il più alto possibile, e prevedere
eventualmente un numero telefonico di backup che trasmetta gli allarmi via GSM anziché via GPRS.

Nome Punto di Accesso (APN) 1 e Nome Punto di Accesso (APN) 2
Questo è un dato che generalmente va richiesto all’operatore che fornisce il servizio GPRS. Inserire in queste caselle il nome
del servizio che fornisce l’indirizzo IP. Nome Punto di Accesso (APN) 2 è considerato un parametro di backup.
 ATTENZIONE: inserire il corretto APN per servizi WAP/GPRS altrimenti alcune funzionalità potrebbero

essere limitate (per maggiori informazioni rivolgersi all'operatore del centro servizi).

Indirizzo IP ricevitore principale, Porta Locale 1 e Porta Allarme 1
In questa casella va inserito l’indirizzo IP del ricevitore ed il numero della porta. Per i ricevitori SYSTEM III e SYSTEM II
inserire l’Indirizzo IP e la porta nella sezione Porta Allarme.

Esempio per operatori Italiani

Opzioni Vodafone Wind TIM

Tipo Richiesta Chiamata Comando di rete SMS

Numero Richiesta 404 40916

Messaggio Credito Residuo *123# PRE CRE SIN
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Indirizzo IP ricevitore di riserva, Porta Locale 2 e Porta Allarme 2
Questa casella prevede l’inserimento del secondo indirizzo IP del ricevitore e del numero della porta, con la differenza che
questi parametri sono considerati come ricevitore di backup. Il Comunicatore riconosce questa casella solo nel caso in cui
sono stati inseriti i parametri relativi ad Indirizzo IP ricevitore principale, Porta Locale 1 e Porta Allarme 1. Inoltre le
caselle Abilita supervisione e Tempo di supervisione si riferiscono solo al ricevitore principale.

Nome utente e Password APN1, Nome utente e Password APN2
Per alcuni operatori è necessario inserire l’autenticazione della comunicazione, per cui, se richiesto, inserire in questi campi
il Nome Utente e la relativa Password. Nome utente e Password APN2 sono considerati dati di backup.

Numeri di telefono da decodificare
Questo Comunicatore permette di comunicare gli eventi con il protocollo Contact ID, tramite la rete GPRS, anche alle centrali
che non supportano questo tipo di comunicazione.
Per fare ciò, si deve programmare un numero telefonico (i numeri telefonici possono essere “virtuali” o “reali”) sulla centrale,
per la comunicazione degli eventi con il protocollo Contact ID (ad es. si può programmare 0123), quindi si deve inserire lo
stesso numero in uno di questi campi (si possono programmare fino a quattro numeri telefonici per questa funzione).
Quando il Comunicatore riconosce una chiamata da uno di questi numeri, automaticamente transcodifica l’evento nel formato digitale
e lo inoltra sulla rete GPRS al ricevitore programmato (vedere le opzioni del “Ricevitore Principale” e “Ricevitore di Riserva”).
 I numeri telefonici devono essere di almeno 2 cifre.

Le opzioni “Prefisso” e “Cifre da rimuovere” NON hanno effetto sui “Numeri di telefono da decodificare”.
I “Numeri di telefono da decodificare” devono essere perfettamente uguali ai numeri di telefono memoriz-
zati nella centrale.
Lasciare questi campi vuoti se non si usa questa funzione.
Per il corretto funzionamento di questa funzione devono essere impostate le opzioni del “Ricevitore
Principale” ed eventualmente del “Ricevitore di Riserva”.

DNIS
Inserire il codice identificativo univoco (se richiesto).

Codice cliente
In questa casella deve essere digitato il Codice identificativo per la comunicazione con i ricevitori SYSTEM III o SYSTEM II.

Abilita Supervisione
Per abilitare la supervisione selezionare questa casella. L’opzione supervisione è disponibile SOLO per il ricevitore
principale. I messaggi di supervisione non vengono inviati durante le chiamate vocali (su GSM).

Tempo Supervisione (sec)
Impostare il Tempo di supervisione. È possibile impostare un Tempo di Supervisione da un minimo di 5 secondi ad un
massimo di 65535 secondi, con passi di 1 secondo.

Programmazione remota (solo per la serie GS3125)
Questa interfaccia permette di utilizzare tramite rete le funzionalità offerte dall’applicazione software GS3100 Series Console.
Tramite questa interfaccia è possibile la gestione da remoto dei parametri del Comunicatore. Per usare questa funzione
visitare l’indirizzo di rete http://www.dscreachme.com.
 Abilitato: per abilitare la programmazione remota fare click su questa casella per inserire il segno di spunta   (di

fabbrica questa impostazione è abilitata).
 Chiave Crittografica: è possibile impostare la chiave crittografica affinchè la programmazione remota sia protetta da

accessi non autorizzati. La chiave crittografica può essere costituita da 1 a 32 caratteri esadecimali. Il valore impostato
di fabbrica è 0 (la chiave crittografica non è usata).

Stato
Questa pagina permette il controllo in tempo reale di tutte le funzioni del Comunicatore.
 ATTENZIONE - Questa pagina viene aggiornata ogni 5 secondi.
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Sezione Stato
In questa sezione sono riportati i dati più importanti del Modulo GSM. Nel display virtuale, oltre al nome del gestore della Rete
GSM, viene visualizzato il livello del segnale GSM, quest’ultimo attraverso un’indicatore.
Le spie di Stato del dispositivo possono essere accese o spente, sono di colore VERDE quando il funzionamento è corretto;
quando sono ROSSE significa che è presente un malfunzionamento o una situazione di guasto; se invece sono ARANCIONE
significa che c’è una comunicazione in corso. Le spie dei Ricevitori GPRS Principale e di Riserva sono ARANCIONE quando
il dispositivo è inizializzato ma NON connesso, oppure quando è connesso ma NON ancora inizializzato.

PTM
Questa pagina è relativa alla “funzione PTM (Panel Transmission Monitoring - Controllo Trasmissione Centrale)” che
permette al dispositivo di inoltrare le chiamate attraverso il canale GSM nel caso in cui la comunicazione tra centrale e
ricevitore fallisce sulla linea telefonica PSTN.
 Il Comunicatore torna al normale modo di funzionamento dopo 5 minuti sul canale GSM.
La funzione PTM considera una comunicazione fallita quando:
– Non rileva la composizione del numero, se abilitata l’opzione “Verifica Composizione” (controlla che venga effettiva-

mente composto un numero telefonico).
– Non rileva il Kiss-off (il segnale che viene inviato dal ricevitore a conclusione di una comunicazione eventi riuscita).
 La frequenza del segnale di Kiss-off è di 1400Hz.
Il controllo viene effettuato su tutti i numeri, se la lista “Numeri di Telefono” è vuota, oppure solo sui numeri presenti nella lista.
Le chiamate vengono inoltrate sul canale GSM quando si raggiunge il numero “Numero Massimo Fallimenti” programmato.
 Numeri di Telefono: inserire i numeri di telefono (fino ad un massimo di 4 numeri telefonici) da chiamare utilizzando la

funzione PTM. Di fabbrica questi campi sono vuoti. Se questi campi sono vuoti, tutti i numeri composti dalla centrale
verranno controllati dalla funzione PTM (Kiss-off attesso a fine comunicazione).

 Verifica composizione: di fabbrica è disabilitato, se abilitato forza a contare il numero di errori dovuti allo sgancio e al
riaggancio (senza comporre nessun numero di telefono) del dispositivo telefonico collegato ai morsetti LI come errore.

 Numero massimo fallimenti: inserire in questo campo il numero totale degli errori rilevati dal Comunicatore oltre il
quale è attivata la funzione PTM. La funzione PTM è disabilitata di fabbrica (l’impostazione di fabbrica è 0); impostare un
valore da 1 a 4 per abilitare la funzione PTM.

Ingressi/Uscite (solo per la serie GS3125)
In questa pagina vengono programmate le modalità Ingresso o Uscita, gli eventi di attivazione per le Uscite, la loro Polarità
a riposo (N.C. o N.A.), le Uscite Riservate, le Stringhe SMS di Attivazione da remoto per le Uscite Riservate.
 Tipo: in questa colonna è possibile programmare i morsetti T1, T2 e T3 per le seguenti modalità:

– Ingresso: selezionare questa modalità per abilitare il morsetto corrispondente come Linea d’Ingresso. La selezione di
questa modalità attiva la colonna Servizio (vedere di seguito).
– Uscita: selezionare questa modalità per abilitare il morsetto corrispondente come Uscita Open-Collector.

 ATTENZIONE - Queste impostazioni aggiornano automaticamente anche i parametri nelle pagine “Avvisatore
SMS”, “Avvisatore Vocale” e “Rubrica Telefonica”.

 Polarità: in questa casella si programma lo stato dell’uscita/ingresso a riposo:
– Normalmente Chiuso  con l’Uscita/ingresso a riposo, il relativo morsetto risulta a massa (negativo).
– Normalmente Aperto  con l’Uscita/ingresso a riposo, il relativo morsetto risulta appeso.
Fare click sulla casella in corrispondenza della colonna “Polarità” per invertire il parametro visualizzato in quel momento.

 Eventi di Attivazione: cliccare nella colonna relativa all’evento da programmare in corrispondenza dell’uscita relativa.
Il segno di spunta  indicherà che in presenza di quell’evento, sarà attivata l’Uscita relativa. Fare click sulle caselle per
inserire/rimuovere il segno di spunta .

 ATTENZIONE - La programmazione degli eventi associati ad un’uscita implica la disabilitazione di alcune caselle relative
alla stessa uscita. Prima di poter programmare bisogna rimuovere i segni di spunta  inseriti nelle varie caselle.

– Guasto PSTN: se selezionata, l’uscita sarà attivata in caso di mancanza della linea telefonica.
– Guasto GSM: se selezionata, l’uscita sarà attivata se viene a mancare la rete GSM.
– Supervisione Fallita: se selezionata, l’uscita sarà attivata in caso di mancanza del messaggio di supervisione.
– Comunicazione fallita (FTC): se selezionata, l’uscita sarà attivata se la comunicazione con il ricevitore non va a buon fine.
  La selezione dell’evento Comunicazione Fallita (FTC) permette di selezionare l’opzione Monostabile ed
il Tempo di Attivazione (Tempo di ON).
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 Uscita Riservata: quando si seleziona questa opzione, tutti gli altri eventi selezionati per attivare l’Uscita corrispondente
vengono ignorati. Fare click sulla casella in corrispondenza dell’Uscita da attivare tramite riconoscimento del chiamante.
Per l’attivazione dell’uscita su riconoscimento del chiamante programmare il numero di telefono sulla pagina “Rubrica
Telefonica” e abilitare l’opzione “Attiva Uscita” (vedere la pagina Rubrica->Attiva Uscita).

 Servizio:  un segno di spunta  in questa colonna indica che il Comunicatore è posto nello Stato di SERVIZIO e cioè in
presenza degli eventi di sbilanciamento sulle Linee di Ingresso 1 e 2, anzichè effettuare una chiamata, il Comunicatore effettuerà
autonomamente una determinata azione. Per ogni Linea è possibile definire un’azione secondo la successiva tabella. In ogni
caso selezionando queste azioni non vengono mai inviati messaggi SMS in corrispondenza degli Ingressi 1 e 2.

 ATTENZIONE - Queste impostazioni aggiornano automaticamente anche i parametri nelle pagine “Avvisatore
SMS”, “Avvisatore Vocale” e “Rubrica Telefonica”.

 Stringa di controllo: digitare in questa colonna la stringa (massimo 16 caratteri alfanumerici) che deve essere inviata
quando si vuole attivare/disattivare l’Uscita corrispondente da remoto tramite SMS. Questa funzionalità è operativa
anche se il riconoscimento del chiamante non è abilitato.

 Conferma attivazione: in questa colonna va
selezionato il tipo di conferma che si vuole
avere quando l’uscita verrà attivata. La scelta è
possibile per 3 diversi valori: Nessuna, Squillo
oppure SMS (quest’ultimo valore non è dispo-
nibile se la casella Stringa di controllo viene
lasciata vuota). Se l’uscita viene attivata trami-
te l’invio di un SMS la conferma di attivazione
dell’uscita viene inoltrata tramite SMS.

 Monostabile: normalmente le Uscite, quando
attivate, permangono nello stato di attivazione
fino al successivo comando di disattivazione,
all’arrivo del quale l’Uscita stessa tornerà nello
stato di riposo. Se si desidera che l’Uscita, una
volta attivata, torni automaticamente nello stato
di riposo dopo un determinato tempo, selezio-
nare questa opzione ed impostarne il tempo di attivazione nella casella Tempo di Attivazione (sec) adiacente.

 Tempo di Attivazione (sec): in questa casella va digitato un valore in secondi (da 1 a 86400 con passi da 1 secondo) che indica
il tempo in cui l’Uscita, se impostata come Monostabile, rimane attiva prima di tornare nuovamente nello stato di riposo (Tempo di ON).

Avvisatore Vocale (solo per la serie GS3125)
In questa sezione si programmano tutti i parametri relativi all’avvisatore vocale, come descritto di seguito:
 Descrizione: in questa colonna sono elencati gli eventi per i i quali è possibile programmare un messaggio vocale.
 Per selezionare i messaggi vocali per le 3 Linee d’Ingresso programmabili impostare il morsetto
corrispondente come Ingresso (vedere pagina Ingressi/Uscite->Tipo).

 Numeri Telefonici: fare click sulle colonne ‘12345678’ in corrispondenza dell’evento desiderato. Il segno di spunta 
indicherà che quel numero di telefono verrà chiamato quando si verificherà un evento. Fare click sulle caselle per
inserire/rimuovere il segno di spunta .
 I numeri telefonici sono i primi 8 programmati nella pagina “Rubrica Telefonica”.

 Messaggio Vocale da inviare: fare triplo-click sulla colonna ‘Messaggio’ in corrispondenza dell’evento desiderato,
quindi cliccare sul pulsante per scorrere l’elenco dei messaggi (è possibile selezionare, se registrati, fino a 8 messaggi
della durata massima di 16 secondi ciascuno) e selezionarne uno. Possono essere collegati fino a 3 messaggi vocali
per ogni evento (Messaggio#1, Messaggio#2, Messaggio#3).

 Tentativi di Chiamata: in questo campo è possibile inserire il numero di tentativi da effettuare (fino ad un massimo di
8 volte) se la chiamata non va a buon fine.

 Ripetizioni Messaggio: in questo campo è possibile inserire il numero di ripetizioni del messaggio vocale (fino ad un
massimo di 8 volte) alla risposta del numero chiamato.

Linea Ingresso n. Selezione

1 A

2 B

Funzione di Servizio associata

Commutazione forzata su Rete GSM

Cancella Coda Telefonica

Black List White List
Chiamata Inoltrata

(solo se il Comunicatore è
commutato su rete GSM)

Abilitato
Disabilitato

Tabella Effetti su Attivazione dell'Uscita

PROGRAMMAZIONE EFFETTI

Conferma
Attivazione

Nessuna
Squillo

Nessuna
Squillo

Nessuna
Squillo

Nessuna
Squillo

SI

NO

SI
NO
NO

NO
SI

NO

NO

SI

NO
SI

NO

SI
NO

SI

Squillo
Conferma
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 Chiama tutti i numeri: selezionare questa opzione  per chiamare tutti i numeri di telefono programmati per un singolo
evento e quindi riprodurre il messaggio vocale assegnato. Se questa opzione non è selezionata  , l’avvisatore
terminerà le chiamate vocali non appena una di esse andrà a buon fine.

 Conferma chiamata: selezionare questa opzione per fare in modo che l’avvisatore attenda la conferma da parte dell’utente
remoto dell’avvenuta ricezione del messaggio vocale, altrimenti l’avvisatore tenterà nuovamente di recapitare il messaggio
vocale; l’utente remoto puo inviare la conferma premendo il tasto  dal suo telefono (valido solo per i telefoni a toni).

 ATTENZIONE - Durante l’ascolto di un messaggio vocale, premendo il tasto   sulla tastiera del
proprio telefono, è possibile bloccare sia la telefonata in corso che tutte quelle eventualmente in coda.
 In certi casi l’avvisatore può interpretare erroneamente la risposta delle segreterie, risponderie, mes-
saggi di cortesia dell'operatore GSM, ecc. si consiglia quindi di abilitare la “conferma chiamata”.

Messaggio Vocale Periodico
In questa sezione vanno programmate le opzioni relative all’invio del Messaggio Vocale Periodico.
 Per impostare le opzioni del Messaggio Vocale Periodico, si deve inserire il “Numero di telefono SIM” e

abilitare l’opzione “Regolazione Orogogio Automatica” nella pagina “Opzioni”.
 Data invio primo Messaggio: selezionare la data per l’invio del primo Messaggio Vocale Periodico.
 Ora invio primo Messaggio: selezionare l’ora per l’invio del primo Messaggio Vocale Periodico.
 Intervallo: digitare in queste caselle l’intervallo (HH-GG) entro il quale inviare i successivi Messaggi Vocali Periodici.

L’intervallo è composto dai seguenti valori:
— (HH) ora prossimo invio - Selezionare il valore per l’invio del successivo Messaggio Vocale Periodico. L’intervallo dei
valori ammissibili va da 0 a 23.
— (GG) giorno prossimo invio - Selezionare il valore per l’invio del successivo Messaggio Vocale Periodico. L’intervallo
dei valori ammissibili va da 0 a 365.

 Aggiorna Ora: selezionando questa icona è possibile ottenere la data e l’ora dal PC.

Modalità servizio locale
Selezionando il pulsante Modalità servizio locale è possibile abilitare la registrazione/riproduzione dei messaggi vocali da
un telefono a toni, collegato ai morsetti LI del dispositivo (vedere “Registrazione dei Messaggi Vocali da locale” e
“Riproduzione dei Messaggi Vocali da locale”).
Quando si abilita questa modalità, i LED Verdi L1 e L2 lampeggiano (vedere Led di controllo->tabella 2). Il lampeggio dei
LED termina solo alla fine della procedura di registrazione o di riproduzione oppure dopo che sono trascorsi 60 secondi senza
premere nessun tasto.
 Per il corretto funzionamento della Modalità Servizio Locale si deve collegare UN SOLO telefono ai morsetti LI.

Avvisatore SMS (solo per la serie GS3125)
Questa pagina è per l’impostazione delle opzioni dell’Avvisatore SMS, come descritto di seguito.
 Tipo Evento: nella colonna ‘Tipo Evento’ sono riportati, per ognuna delle 11 righe, gli eventi in presenza dei quali è

previsto, se opportunamente programmato, l’invio di due SMS: uno di attivazione, l’altro di ripristino (per l’evento ‘SMS
periodico’ è previsto l’invio del solo Messaggio SMS di attivazione).
 Per selezionare i messaggi SMS per le 3 Linee d’Ingresso programmabili impostare il morsetto
corrispondente come Ingresso (vedere il paragrafo Ingressi/Uscite->Tipo).

 Numeri di Telefono: fare click sulle colonne ‘12345678’ in corrispondenza dell’ingresso desiderato. Il segno di spunta
 indicherà che a quel numero di telefono verrà inviato il messaggio SMS al verificarsi dell’evento corrispondente.
 I numeri telefonici sono i primi 8 programmati nella pagina “Rubrica Telefonica”.

 Stringa SMS: nella colonna ‘Stringa SMS’, cliccare sulla casella corrispondente al messaggio da programmare e
digitare il messaggio da inviare al verificarsi dell’evento corrispondente (massimo 100 caratteri).

SMS Periodico
In questa sezione vanno programmate le opzioni relative all’invio dell’SMS Periodico.
 Per impostare le opzioni del Messaggio SMS Periodico, si deve inserire il “Numero di telefono SIM” e

abilitare l’opzione “Regolazione Orogogio Automatica” nella pagina “Opzioni”.
 Data invio primo SMS: selezionare la data per l’invio del primo SMS Periodico.
 Ora invio primo SMS: selezionare l’ora per l’invio del primo SMS Periodico.
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 Intervallo: digitare in queste caselle l’intervallo (HH-GG) entro il quale inviare i successivi SMS Periodici. L’intervallo è
composto dai seguenti valori:
— (HH) ora prossimo invio - Selezionare il valore per l’invio del successivo SMS Periodico. L’intervallo dei valori
ammissibili va da 0 a 23.
— (GG) giorno prossimo invio - Selezionare il valore per l’invio del successivo SMS Periodico. L’intervallo dei valori
ammissibili va da 0 a 365.

 Aggiorna Ora: selezionando questa icona è possibile ottenere la data e l’ora dal PC.

Messaggio Vocale (solo per la serie GS3125)
Questa pagina è per la registrazione e la riproduzione dei messaggi vocali: fare riferimento alla pagina Avvisatore Vocale
per l’associazione dei messaggi agli eventi. Per aprire l’archivio dei messaggi vocali cliccare sull’icona a sinistra del
pulsante REGISTRA, sulla destra del campo “WAV File#1”.
 Il Comunicatore supporta solo file audio WAVE (.WAV), della durata massima di 16 secondi, con i seguenti attributi:

PCM, 8000 Hz, 8 bit, Mono, non compresso. È possibile utilizzare file preregistrati che rispettino il formato indicato.

Pulsante RIPRODUCI - Premere questo pulsante per riascoltare il messaggio vocale.

Pulsante REGISTRA - Premere questo pulsante per iniziare la registrazione di un nuovo messaggio vocale.

Pulsante STOP - Premere questo pulsante per fermare la riproduzione o la registrazione corrente del messaggio vocale.

Pulsante CARICA - Premere questo pulsante per caricare il messaggio vocale registrato.

Pulsante INVIA - Premere questo pulsante per inviare al Comunicatore il messaggio vocale registrato.

Pulsante CANCELLA - Premere questo pulsante per cancellare direttamente il messaggio vocale presente nel Comunicatore.

Durante la registrazione del messaggio, una barra di avanzamento indica, in tempo reale, il tempo trascorso.

Registrazione dei Messaggi Vocali da locale
 Per il corretto funzionamento della Registrazione dei Messaggi Vocali da locale si deve collegare UN SOLO

telefono ai morsetti LI.
Per registrare un messaggio vocale da un telefono a toni collegato ai morsetti LI, abilitatare la Modalità Servizio Locale
nella pagina Avvisatore Vocale, quindi procedere come descritto di seguito:
1. Premere il tasto ;

2. Premere in sequenza i tasti  per entrare nella modalità di registrazione;

3. Digitare il numero del messaggio che si vuole registrare (da  a );
4. Dopo il Beep registrare il messaggio vocale (la durata massima del messaggio vocale è di 16 secondi);
5. Premere il tasto   per confermare la registrazione del messaggio (oppure premere sempre il tasto   se si vuole

interrompere anticipatamente la registrazione del messaggio), verrà generato un tono Boop;
Da questo momento, qualsiasi registrazione effettuata in precedenza per quel messaggio VIENE CANCELLATA;

6. Se è necessario registrare altri messaggi, ripetere la procedura dal punto 1.

Riproduzione dei Messaggi Vocali da locale
 Per il corretto funzionamento della Riproduzione dei Messaggi Vocali da locale si deve collegare UN SOLO

telefono ai morsetti LI.
Per riprodurre un messaggio vocale da un telefono a toni collegato ai morsetti LI, abilitare la Modalità Servizio Locale nella
pagina Avvisatore Vocale, quindi procedere come descritto di seguito:
1. Premere il tasto ;

2. Premere in sequenza i tasti  per entrare nella modalità di riproduzione;

3. Digitare il numero del messaggio che si vuole ascoltare (da  a );
4. Dopo il Beep viene riprodotto il messaggio al termine del quale viene generato un tono Boop di conferma (premere il tasto
 se si vuole interrompere anticipatamente la riproduzione del messaggio);

5. Se è necessario ascoltare altri messaggi, ripetere la procedura dal punto 1.
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PC-LINK

PC1864

GS3125

Programmazione opzionale Antisabotaggio
Tramite il collegamento (vedere il paragrafo Collegamenti->Collegamenti Ausiliari ) del Deviatore Antisabotaggio
MAXIASNC (opzionale) è possibile rilevare eventuali tentativi di manomissione del coperchio del Comunicatore. Per inviare
un messaggio SMS e/o vocale a uno o più numeri telefonici programmati alla rimozione del coperchio del Comunicatore
effettuare, tramite il software GS3100 Series Console, la seguente programmazione:
1) Nella pagina Rubrica Telefonica programmare i numeri di telefono ai quali si vuole che sia inviato il messaggio di allarme.
2) Nella pagina Ingressi/Uscite programmare; il morsetto T3 nella colonna Tipo come Ingresso e nella casella Polarità

lo stato dell’ingresso a riposo come Normalmente Aperto NO (la configurazione a riposo del Deviatore Antisabotaggio è
del tipo Normalmente Chiuso NC).

3) Nella pagina Avvisatore SMS e/o Avvisatore Vocale programmare per l’attivazione dell’ingresso 3 sia il messag-
gio SMS e/o vocale che i numeri di telefono ai quali inviare il messaggio.

PASS-THROUGH (solo per la Serie GS3125)
Questa funzione permette alla Centrale Serie Power PC1864 (PC 1864 4.1 EU, PC 1864 4.2 EU, PC 1864 4.2 ADT Spain,
PC 1864 4.5 ADT Spain, PC 1864 4.5 EU) di essere programmata da remoto via GPRS usando il Comunicatore GS3125
e l’applicazione software DLS IV INT aggiornata con il Driver pack for the GS3125. Il Comunicatore deve essere
opportunamente programmato prima di essere collegato alla Centrale Serie Power PC1864.

Programmazione del Comunicatore
Per programmare il Comunicatore vedere il paragrafo “Programmazione da PC”. Tramite l’applicazione GS3100 Series
Console, effettuare le seguenti programmazioni:
1. Abilitare sul Comunicatore la programmazione remota (vedere il paragrafo GPRS->Programmazione remota).
2. Programmare sul Comunicatore un Nome Punto di Accesso (APN) valido (vedere il paragrafo GPRS).

Collegamento del Comunicatore alla Centrale Serie Power PC1864
Per collegare la Centrale Serie Power PC1864 al Comunicatore GS3125 è necessario utilizzare il cavo PCLINK-PCLINK
(vedere la figura 6) collegato tra il connettore PC-LINK [9] del Comunicatore e il connettore PC-LINK della Centrale, facendo
attenzione al verso di inserimento del connettore.
 ATTENZIONE: collegare il cavo PCLINK-PCLINK come indicato in figura 6, notare che il filo bianco del connettore

del cavo PCLINK-PCLINK deve essere collegato al pin 4 del connettore PC-LINK del Comunicatore e della Centrale.

Operazioni da effettuare sulla Centrale Serie Power PC1864
Effettuare le seguenti verifiche sulla Centrale Serie Power PC1864:
1. Controllare la sezione 382 della Centrale, l’opzione 5 deve essere impostata su ON.

Fig. 6 -  Collegamento del
Comunicatore alla Centrale
DSC Serie Power tramite il
cavo PCLINK-PCLINK.
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2. L’operatore digita
il messaggio SMS sul proprio
telefono copiando
le informazioni visualizzate

3. Il messaggio SMS con
IP pubblico e Porta del DLS
viene inviato al GS3125.

Centrale DSC Serie POWER

5. DLS comunica con
la centrale DSC (Opzioni
Upload/Download) attraverso
il GS3125.

4. Il GS3125 si 
connette al DLS via
GPRS.

2. NON devono essere presenti guasti, il LED VERDE sulla Centrale deve essere ACCESO: questo permette di stabilire che
la Centrale riconosce il Comunicatore GS3125 come collegato e funzionante.

Operazioni da effettuare sul PC
Effettuare le seguenti operazioni sul PC prima della programmazione da remoto con l’applicazione software DLS IV INT:
1. Il PC deve avere un indirizzo IP pubblico e una porta pubblica per le connessioni in ingresso dell’applicazione software DLS IV INT.
2. Il firewall ed il router devono permettere sul PC la connessione della porta pubblica alla porta 51004 dell’applicazione

software DLS IV INT.
3. Assicurarsi che sia possibile accedere alla porta pubblica del router da un altro PC per verificare se l’applicazione software

DLS IV INT puo essere raggiunta dal dispositivo.

Programmazione remota tramite software DLS IV INT
Per effettuare la programmazione della Centrale da remoto è necessario avere installato sul proprio PC l’applicazione
software DLS IV INT con il pacchetto dei driver di aggiornamento scaricabili dal sito DSC.
 ATTENZIONE: al fine di ottenere il supporto sul DLS IV INT per GS3125, e necessario installare il “Driver

pack for the GS3125”.
Prima di avviare una connessione remota via GPRS tra il Comunicatore e l’applicazione software DLS IV INT è necessario inviare un
messaggio SMS tramite un telefono GSM al Comunicatore, pertanto, è necessario conoscere il numero di telefono assegnato alla SIM
card. Nella finestra “SMS Message Generator” del software DLS IV INT sono visibili le informazioni necessarie per la creazione del
testo del messaggio SMS da inviare al Comunicatore, per visualizzare questa finestra eseguire i seguenti passi:
1. Avviare l’applicazione software DLS IV INT sul vostro PC.
2. Creare un “New Account” inserendo il tipo di Centrale (per esempio, PC1864 v4.2EU) e il tipo di connessione

“Connection Type”, per esempio “SMS (GS GS3125)”.
3. Inserite le informazioni necessarie, fare click su “Create”.
4. Andare sulla sezione GS/IP del menu ed inserire il Codice Installatore nel campo “GS/IP Installers Code” (massimo 4 caratteri

numerici, vedere il paragrafo “Programmazione da PC->Opzioni->Codici->Codice Installatore”) e “IMEI” del Comunicatore.
5. Fare click per esempio sull’icona “Global Upload” e scegliere SMS come “Connection Type” quindi fare click su “OK”.
6. Viene visualizzata una finestra “SMS Message Generator”, dove ci sono le informazioni necessarie per la creazione del

testo del messaggio SMS (ad esempio: #DLS#11122233344451004).
7. Sulla finestra “SMS Message Generator” fare clik su “OK”. L’applicazione software DLS IV INT rimane in attesa della

connessione con il Comunicatore.
8. Inviare il messaggio SMS al Comunicatore tramite il proprio telefono GSM.
9. Dopo aver ricevuto il messaggio SMS, se corretto, il Comunicatore avvia una connessione remota via GPRS con

l’applicazione software DLS IV INT. Tramite l’applicazione software DLS IV INT, è ora possibile comunicare da remoto via
GPRS con le centrali Serie Power PC1864.

Fig. 7 -  Programmazione remota tramite software DLS IV INT.
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NOTES
This product uses the FreeRTOS.org real time kernel.

The FreeRTOS.org source code can be obtained by visiting
http://www.FreeRTOS.org

FreeRTOS LICENSING:
“The FreeRTOS source code is licensed by the GNU General Public License (GPL) with an exception.

The full text of the GPL is available here:
http://www.freertos.org/license.txt.

The text of the exception is available on FreeRTOS official website:
http://www.FreeRTOS.org - License and Warranty Page

The exceptions permits the source code of applications that use FreeRTOS soley through the API published on this
WEB site to remain closed source, thus permitting the use of FreeRTOS in commercial applications without

necessitating that the whole application be open sourced. The exception should only be used if you wish to combine
FreeRTOS with a proprietary product and you comply with the terms stated in the exception itself.”
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